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1 Printing this guide

Change the paper size to print this document on any printer.

1. Open the PDF file in Adobe Acrobat.

2. From the File menu, select Print Setup.

The Print dialog box appears.

3. In the Print Setup dialog box, under Paper, in the Size list, select the

desired paper size, for example, A4 or letter.

4. From the File menu, select Print.

5. In the Page Scaling list, select Fit To Printable Area or Shrink To

Printable Area.

Note: The names in the Page Scaling list vary according to the version of the

Adobe Acrobat software.

6. Click OK.

This document is printed on either A4 or letter size paper.
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2 Safety information

(multilingual)

2 .1 Safety precautions
The following safety information includes instructions about avoiding

personal injury, before and while servicing the Color Controller C-81.

2 .1 .1 General safety

This product is not categorized as a workstation according to §2 of

“Regulation on Work on Screens” (EK1-ITB 2000:2010).

Follow these rules to ensure general safety:

● Lift up the Color Controller C-81 using the handle and not using the

front panel. Lifting it up using the front panel may result in major

injury.

● Before opening the Color Controller C-81 covers, ensure that the unit

has been switched off. Switching off, only the ON/OFF power

button, will leave some circuits energized. For complete

disconnection from the supply, the main power cable must also be

disconnected from the power source.

2 .1 .2 Battery replacement

Only qualified service personnel should replace the battery.

Handle used batteries and dispose of them according to the lithium

battery manufacturer's instructions.



2 .1 .3 Static electricity

When handling static-sensitive electric devices (for example,

electronic boards, disk drives, or memory modules), follow these

guidelines:

● Use a field service grounding kit (chain, mat, and wrist strap).

● After removing the component from the system or from its

protective wrapper, place the component on a grounded

antistatic mat—not on a carpet or any other unshielded surface.

● After removing a board from a server, store the board in an

antistatic bag.

2 .2 Sicherheitsmaßnahmen
Die folgenden Abschnitte enthalten Sicherheitsinformationen zur

Vermeidung von persönlichen Verletzungen vor und während der

Wartung des Color Controller C-81.

2 .2 .1 Allgemeine Sicherheit

Das Produkt ist nicht für den Einsatz an Bildschirmarbeitsplätzen

im Sinne §2 der Bildschirmarbeitsplatzverordnung geeignet (EK1-

ITB 2000:2010).

Befolgen Sie diese Regeln, um allgemeine Sicherheit zu

gewährleisten:

● Heben Sie den Color Controller C-81 nur am Griff hoch und

berühren Sie nicht die Frontblende. Wenn Sie ihn an der

Vorderblende hochheben, kann dies zu schweren Verletzungen

führen.

● Bevor Sie die Schutzabdeckung des Color Controller C-81

öffnen, stellen Sie sicher, dass die Einheit ausgeschaltet wurde.

Wenn Sie das Gerät nur mit der ON/OFF-Schalttaste

ausschalten, bleiben einige Stromkreise aktiviert. Um eine

vollständige Trennung von der Stromversorgung zu erreichen,

muss der Hauptlastschalter von der Stromquelle getrennt sein.
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2 .2 .2 Batterieaustausch

● Die Batterie sollte nur von qualifiziertem Kundendienstpersonal

ausgetauscht werden.

● Handhaben und entsorgen Sie die verbrauchten Batterien

entsprechend den Anweisungen des Lithiumbatterie-Herstellers.

2 .2 .3 Reibungselektrizität

Beim Umgang mit statik-empfindlichen elektrischen Geräten (wie z.B.:

elektronische Karten, Plattenlaufwerke oder Speichermodule):

● Benutzen Sie einen Erdungsmontagesatz für den Außendienst

(Kette, Matte und Manschetten).

● Nach dem Entfernen des Teils aus dem System oder aus seiner

Schutzhülle stellen Sie es auf eine geerdete anti-statische Matte und

nicht auf einen Teppich oder auf andere ungeschützte Oberflächen.

● Nachdem Sie die Steckkarte aus einer Station entfernt haben,

bewahren Sie sie in einer anti-statischen Tüte auf.

2 .3 Medidas Preventivas de Seguridad
Las secciones a continuación contienen información de seguridad para

evitar lesiones, antes y durante la prestación de servicio de

mantenimiento y reparaciones del Color Controller C-81.

2 .3 .1 Seguridad General

Siga las siguientes reglas para garantizar la seguridad general:

● Levante el Color Controller C-81 utilizando el mango y no el panel

frontal. Al levantarlo utilizando el panel frontal se pueden ocasionar

serias lesiones.

● Antes de abrir las cubiertas del Color Controller C-81, asegúrese de

que la unidad ha sido apagada. Si se apaga utilizando el botón ON/

OFF solamente, algunos circuitos permanecen activados. Para una

desconexión completa del suministro de energía, el cable de

alimentación principal se debe desconectar de la fuente de

alimentación.
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2 .3 .2 Sustitución de la batería

● Sólo un ingeniero de mantenimiento y reparaciones debe

reemplazar la batería.

● Manipule y deshágase de las baterías usadas de acuerdo a las

instrucciones del fabricante de la batería de litio.

2 .3 .3 Electricidad estática

Cuando se manejan dispositivos eléctricos sensibles a electricidad

estática (como por ejemplo: placas electrónicas, unidades de

disco, o módulos de memoria):

● Use un kit de puesta a tierra para reparaciones y

mantenimiento en terreno (cadena, felpudo y banda de

muñeca).

● Después de sacar el componente del sistema o de su lugar de

envoltura de protección, colóquelo en un felpudo antiestático

puesto a tierra y no en una alfombra o cualquier otra superficie

no protegida.

● Después de sacar una placa de una estación, almacénela en una

bolsa antiestática.

2 .4 Mesures de sécurité
Les sections suivantes contiennent des informations sur les

mesures de sécurité à prendre pour éviter les blessures

personnelles, avant et pendant l'entretien du Color Controller C-81.

2 .4 .1 Mesures générales de sécurité

Suivez ces règles pour garantir une sécurité générale :

● Soulevez le Color Controller C-81 par la poignée et non par le

panneau frontal. L'utilisation du panneau frontal pour soulever

le dispositif peut entraîner des blessures graves.

● Avant d'ouvrir les couvercles du Color Controller C-81 vérifiez

que l'unité a été éteinte. Si vous ne mettez hors tension que

l'interrupteur ON/OFF, certains circuits resteront sous tension.

Pour une déconnexion totale de l'alimentation en courant, le

câble d'alimentation principale doit aussi être déconnecté du

bloc d'alimentation.
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2 .4 .2 Remplacement de la batterie

● Le remplacement de la batterie est une opération réservée au

personnel de service qualifié.

● Manipulez et jetez les batteries utilisées selon les instructions du

fabriquant de batterie au Lithium.

2 .4 .3 Electricité statique

Lors de la manipulation des périphériques électriques sensibles à

l'énergie statique (tels que : les cartes électroniques, les lecteurs de

disque ou les barrettes de mémoire) :

● Utilisez une trousse de mise à terre (une chaîne, une carpette et un

bracelet anti-statique).

● Après avoir enlevé le composant du système ou de son emballage

de protection, placez-le sur une carpette anti-statique mise à la

terre et non sur une carpette ou sur n'importe quelle autre surface

non protégée.

● Après l'enlèvement d'une carte d'un poste, conservez-la dans un

emballage anti-statique.

2 .5 Precauzioni di Sicurezza
Le seguenti sezioni contengono informazioni di sicurezza riguardanti

l'evitamento di lesioni personali, prima e durante l'uso del Color

Controller C-81.

2 .5 .1 Sicurezza generale

Seguite queste istruzioni per assicurare la sicurezza generale:

● Alzate il Color Controller C-81 usando la maniglia e non usando il

panello frontale. Alzandolo usando il panello frontale potrebbe

causare una grave lesione.

● Prima di aprire la copertura del Color Controller C-81 , assicuratevi

che l'unità sia stata spenta. Spegnendo l'unità, solo il pulsante ON/

OFF lasciera qualche circuito alimentato. Per arrivare a una

sconnessione completa dalle fonti di alimentazione, il cavo di
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alimentazione principale deve essere staccato dal connettore di

alimentazione.

2 .5 .2 Sostituzione della Batteria

● La batteria dovrebbe essere cambiata solo dal personale di

assistenza qualificato.

● Disfatevi delle batterie usate a seconda delle istruzioni del

fabbricante riguardanti batterie Lithium.

2 .5 .3 Elettricità Statica

Quando gestite dispositivi di sensitività elettro-statica (come:

schede elettroniche, dischi rigidi o moduli di memoria):

● Usate un campo di servizio di attrezzatura messa a terra

(catena, stuoia, cinghia da polso).

● Dopo avere rimosso il componente dal sistema o dal cartoccio

protettivo, mettetela su una stuoia anti-statica a terra e non su

un tappeto o ogni altra superficie non protetta.

● Dopo avere rimosso una scheda dalla stazione, custoditela in

una borsa anti-statica.

2 .6 Veiligheidsmaatregelen
In de volgende secties worden veiligheidsmaatregelen behandeld

om persoonlijk letselt voor en tijdens het bedienen van de Color

Controller C-81 te voorkomen.

2 .6 .1 Algemene veiligheid

Volg onderstaande regels op om uw algemene veiligheid te

verzekeren:

● Gebruik het handvat om de Color Controller C-81 op te tillen, en

niet het voorpaneel. Wanneer u het voorpaneel gebruikt bij het

optillen kan dit resulteren in ernstig letsel.

● Zorg ervoor dat de Color Controller C-81 is uitgeschakeld

voordat u de deksels opent. Wanneer u alleen de ON/OFF

schakelaar uitschakeld zullen bepaalde electriciteitscircuits
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geactiveerd blijven. Om de stroomtoevoer volledig af te sluiten moet

de electriciteitskabel uit het stopkontact zijn.

2 .6 .2 De batterij vervangen

● De batterij mag alleen door bevoegd servicepersoneel worden

vervangen.

● Volg de instructies van de fabrikant op voor het vervangen en het

wegwerpen van gebruikte lithium batterijen.

2 .6 .3 Statische electriciteit

Wanneer u met electrisch statisch geladen onderdelen omgaat (zoals:

electronische kaarten, harde schijven of geheugenmodi):

● Gebruik een onderhoudsaardingpakket (ketting, mat, en een

polsbandje).

● Nadat u het onderdeel van het systeem verwijderd of uit zijn

beschermend omhulsel neemt, plaatst u dit op een geaarde anti-

statische mat en niet op een vloerkleed of enig andere

onbeschermde oppervlakte.

● Nadat u een kaart van een station heeft verwijderd plaatst u deze in

een anti-statisch zak.

2 .7 Precauções de segurança
As seguintes sessões contêm informações de segurança com respeito

a como evitar feridas corporais, antes e no decorrer do uso do Color

Controller C-81.

2 .7 .1 Segurança geral

Siga as seguintes regras para assegurar uma segurança geral:

● Levante o Color Controller C-81 usando o cabo e não o painel

frontal. Ao levantá-lo através do painel frontal pode causar sérios

danos.

● Antes de abrir as tampas do Color Controller C-81, certifique-se de

que a unidade foi desligada. Ao desligar somente com o botão ON/

OFF fará com que alguns circuitos sejam ativados. Para uma

desconexão completa da fonte de alimentação, o cabo de

De batterij vervangen 9



alimentação principal também deve ser desconectado da fonte

de alimentação.

2 .7 .2 Troca de bateria

● A bateria deve ser substituída somente por uma equipe de

serviço qualificada.

● Manipule e jogue fora as baterias usadas de acordo com as

instruções do fabricante de baterias de Lítio.

2 .7 .3 Eletricidade estática

Ao lidar com dispositivos sensíveis à energia estática (como:

placas eletrônicas, unidades de disco ou módulos de memória):

● Utilize um kit de aterramento de serviço (cadeia, esteira e faixa

de pulso).

● Após a remoção do componente do sistema ou do seu

invólucro de proteção, coloque-o em uma esteira anti-estática e

não em um tapete ou qualquer outra superfície desprotegida.

● Após remover uma placa de uma estação, armazene-a em uma

bolsa anti-estática.
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3 Product overview

3 .1 Introduction to the Color Controller C-81
The Color Controller C-81, powered by Creo color server technology is

an on-demand server that uses advanced prepress technologies to drive

the Pro C901/C901S.

The Color Controller C-81 enables you to print from computers running

the Microsoft Windows operating system and Apple Mac OS operating

system software. Using raster image processor (RIP) technology, the

Color Controller C-81 converts image files in page-description language

(PDL) formats—for example, Adobe PostScript, PDF, and variable data

printing formats—to a suitable ready-to-print (RTP) format for direct

highquality digital printing. The Color Controller C-81 also streamlines

the printing process by allowing you to print with preset workflows.

In combination with the printer, the Color Controller C-81 enables you

to efficiently print flyers, brochures, pamphlets, dummy catalogs, short-

run trials, and print-on-demand publications. When installed as a

network printer with the Color Controller C-81, the press prints at the

full-rated speed.The Color Controller C-81 combines RIP functionalities,

automation, control tools, and special hardware development

capabilities with Windows-based architecture.

3 .2 Color Controller C-81 components

The Color Controller C-81 is a Creo dedicated platform running in a

Microsoft Windows XP Professional system. There are four main

groups of components:

● Dedicated Creo hardware, including the interface board

● Off-the-shelf hardware

● DVD-RW drive with DVD burning software

● Software including:

○ Color Controller C-81 software

○ Windows XP Professional for embedded solutions

○ Microsoft Internet Explorer 6



○ Adobe Acrobat 9.0 and PDF 1.7

○ Enfocus PitStop Edit

3 .3 Functionality and features
The features and functions of the Color Controller C-81 include:

● Efficient variable information printing

● Enhanced job-editing capabilities

● Image-enhancement capabilities

● Color management tools

● Enhanced text and line-art quality

● Post-RIP imposition

● Job management

● On-screen preview and editing

● Print jobs at machine-rated speed

● RIP—Adobe Postscript Level 3 and Extreme certified

technologies

● Ready-to-print job format for immediate reprint

● Extensibility—scalable, modular, and with multiple upgrade

paths

3 .4 Supported formats
The Color Controller C-81 supports the following file formats:

● PostScript (composite or pre-separated files) (levels 1, 2, and 3)

● Adobe PDF (versions 1.2 through 1.7)

● EPS

● Creo VPS (Variable Print Specification)

● PPML (Personalized Print Markup Language)

● PPML.zip

● PPML/VDX

● File formats from various prepress systems, for example, Kodak 

Brisque and TIFF/IT software

● CT, LW

● JPEG

● TIFF

● Pre-separated formats
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3 .5 Supported client platforms
The system is capable of receiving and processing jobs from a variety

of operating systems and monitoring the jobs all the way to the

printout.

● Mac OS X

● Windows

● Unix

3 .6 Product configuration

The diagram below shows the modular system architecture of the

Color Controller C-81.

Figure 1: Color Controller C-81 configuration

The following list corresponds to the above diagram. Each number

provides details about a specific part of the Color Controller C-81

architecture.

1. System/user partitioned disk:

● 2 × 500 GB hard disk

Supported client platforms 13



○ Windows XP Professional (on C:\)

○ Apple Macintosh shared folder, including various utilities

and PPD (on D:\)

○ Default path for APR high-resolution files is D:\Shared
\High Res

○ Spool area on hard disk containing the PostScript files

○ Other data used for Color Controller C-81 software(on D:
\)

2. FusionRA board:

● Data decompression

● Page assembly

● FusionRA board supports color separations

3. Two image disks:

● 500 GB each

● After processing (RIPing), rasterized jobs are sent to (and

stored on) the image disks as RTP jobs

● Jobs stored on the image disks are changed or deleted via

the Color Controller C-81 software

4. Gigabit ethernet connection:

● Enables high-speed connection to the network

3 .7 Disk configuration

The following table outlines the Color Controller C-81 disk

configuration.

Disk 0 / Disk

1

C:

Windows XP Professional

Color Controller C-81

software

D:

Spool files

Shared files

Output directory files

Automatic Picture

Replacement (APR) high-

resolution files

Backup folder

Disk 2 Image storage

Disk 3 Image storage
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4
Upgrading the Color

Controller C-81 to version

1.1

This section describes how to the install version 1.1 software. Perform

this upgrade when Color Controller C-81 1.0 is installed.

The upgrade procedure includes the following steps on the Color

Controller C-81 :

1. Archive any important customer jobs to an external device.

2. Back up your system configuration from the Configuration backup in

the Preferences window.

3. Update the firmware for a RAID system.

4. Configure the RAID volumes.

5. Run the complete installation from DVD 1.

6. Install version 1.1.

7. Restore your system configuration from the Configuration backup in

the Preferences window.

8. Retrieve your jobs.

On the the client computer:

1. Uninstall the client software.

2. Reinstall the client software.

Note: If any anti-virus software is running on the Color Controller C-81, disable this

software before installing version 1.1. Once you install version 1.1, the anti-virus

software can be enabled.

4 .1 Backing up the Color Controller C-81 1.0

configuration and resources
The backup and restore configuration feature enables you to backup

your Color Controller C-81 configuration so that you can restore it when

necessary.

Make sure that you backup the system configuration to a network or an

external drive.



1. From the File menu, select Preferences.

2. In the Preferences window, under Administrator, select

Configuration backup.

3. In the Configuration backup area, click Browse.

The Save dialog box appears.

4. Locate the desired folder for backup.

5. Enter a name for the file.

For best results, use the current date as part of the file name.

6. Click Save.

7. In the Configuration backup area, click Start Backup.

After a few moments, the Backup Completed message

appears.

8. Click OK.

9. Click Save to close the Preferences window.

10. Copy the files to an external server. When you upgrade the

installation will wipe out the backup files on the Color

Controller C-81.

4 .2 Archiving jobs
Requirements: A folder for storing the archived jobs.
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If you are archiving a VDP job, you will need to archive the cached

elements separately (see the Color Controller C-81 User Guide ).

1. In the Storage area, right-click the job(s) that you want to archive

and select Archive.

2. Locate the desired folder, and then click Archive.

A cabinet file (an archive file) that contains all the files related to

the archived job(s) is created at the selected location.

4 .3 Updating firmware for a RAID system
The firmware on your Color Controller C-81 must be setup for RAID

before you configure the RAID volumes.

1. If the Color Controller C-81 is on and the Color Controller C-81

workspace is open:

a. Exit the workspace.

b. Place DVD 1 into the DVD-RW drive.

c. From the Windows Start menu, select Shut Down > Restart >

OK.

The Color Controller C-81 shuts down and restarts. The Creo

Color Server startup menu appears.

Creo Color Server startup menu
==============================
1)    Complete installation (overwrite all 
existing data)
2)    Preservation installation (overwrite 
system partition only)
3)    System backup and restore
4)    Firmware setup 
5)    Exit
Select an option [1, 2, 3, 4 or 5]:
Proceed to step 3 on page 18
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2. If your Color Controller C-81 is off:

a. Press the Power On/Off button on the front panel.

b. As soon as power is applied, place DVD 1, into the DVD-

RW drive.

The Creo Color Server startup menu appears.

Creo Color Server startup menu
==============================
1)    Complete installation (overwrite 
all existing data)
2)    Preservation installation 
(overwrite system partition only)
3)    System backup and restore
4)    Firmware setup 
5)    Exit
Select an option [1, 2, 3, 4 or 5]:

3. To perform a firmware setup, press 4.

4. Press 1 to begin the procedure.

5. Press y to confirm.

Important: While the firmware setup is in progress, do not restart or turn

off the computer.

6. After the firmware setup is completed, press any key to

continue.

7. Press Enter to restart the computer.

8. While the computer restarts, press <Ctrl+I> to enter the

Configuration Utility.

9. Continue with Configuring new RAID volumes.
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4 .4 Configuring new RAID volumes
Perform the procedures described in this section if you are upgrading

your non-RAID disks to RAID disks.

1. From the Windows Start menu, select Shut Down > Restart > OK.

2. While the Color Controller C-81 is restarting, press <CTRL+I> to

enter the Configuration Utility.

Important: If you do not press <CTRL+I>, the Color Controller C-81 starts

normally and you will then have to repeat this procedure.

3. To create a RAID system volume, select 1. Create RAID Volume

and press Enter.

4. Press Enter to keep the default volume name.

5. Press Enter to keep the default RAID Level (RAID0(Stripe).

6. Press Enter to choose Select Disks.

A window appears listing the available disks.

7. Using the Up and Down arrows, navigate to disk 0, and then press

the space bar to choose the disk.

8. Using the Up and Down arrows, navigate to disk 1, and then press

the space bar to choose the disk.

9. Press Enter to confirm your selection of disks for the volume.

10. Press Enter to choose the Stripe Size (128KB).

11. Press Enter to choose the Capacity (931.5 GB).

12. Press Enter to create the specified volume.

A message appears warning you that all data on the selected disks

will be lost.

13. Type y to continue.

The volume is created and added to the list of RAID volumes.
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14. To create the image volume, select 1. Create RAID Volume

and press Enter.

15. Press Enter to keep the default volume name.

16. Press Enter to keep the default RAID Level (RAID0(Stripe).

17. Press Enter to choose the Stripe Size (128KB).

18. Press Enter to choose the Capacity (931.5 GB).

19. Press Enter to create the specified volume.

A message appears warning you that all data on the selected

disks will be lost.

20. Type y to continue.

The volume is created and added to the list of RAID volumes.

21. Make sure that DVD 1 is in the DVD-RW drive.

22. Using the arrow keys choose 5. Exit and then press Enter to

exit the configuration utility.

A message appears asking you to confirm that you want to

exit the Configuration Utility.

23. Press y to continue.

The Creo Color Server startup menu appears.

24. Perform a complete installation as described in Installing the

operating system and software.

See also:

Installing the operating system and software on page 58

4 .5 Installing Color Controller C-81 1.1 software

1. Insert the version 1.1 software DVD into the DVD device and

browse to the Color Controller C-81 folder.

2. Double-click the setup.exe file.

3. In the License Agreement window, click Yes. Wait until the

installation is completed.

4. Click Finish to restart the Color Controller C-81.

The system is restarted and the Color Controller C-81

software automatically starts.

5. From the Help menu, select About to verify that Color

Controller C-81 version 1.1 is installed.
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Next:

● Restore the configuration that you backed up. When you restore the

configuration, all the custom spot colors, virtual printers, new fonts,

color profiles and so on, are saved again to the Color Controller C-81

version 1.1 software.

● You will need to remove and then reinstall the network printers on

your client workstation after you have upgraded the software.

4 .6 Restoring Color Controller C-81 1.0 configuration

and resources

1. Copy the backed up files from the external server to the Color

Controller C-81.

2. From the File menu, select Preferences.

3. In the Preferences window, under Administrator, select

Configuration backup.

4. In the Restore configuration area, click Browse.

The Open dialog box appears.

5. Locate the directory path in which you copied the configuration.

6. Select the file you saved for backup, and then click Open.

7. Click Start Restore.

8. Select all the categories, and click OK.

9. After a few moments, the Restore complete message appears.

Click OK.

10. Click Save to close the Preferences window.

11. From the File menu in the workspace, select Exit.

12. Restart the Color Controller C-81.

Restoring Color Controller C-81 1.0 configuration and resources 21



4 .7 Retrieving jobs
Requirements: If you are retrieving a VDP job, then you need to

restore the cached elements first

When you retrieve a job, the archived job retains the original job

name, and not the name assigned when archived. The files related

to the job (for example, PDL) are also retrieved and the cabinet file

is not deleted.

1. From the File menu, select Retrieve from archive.

2. Find the archived job under its archive name, and select the

related cabinet file.

3. Click Add.

The selected job appears in the lower list.

4. Click Retrieve.

The selected job appears at the top of the list in the Storage

area.

5. In the Job History window, verify that the file has been

successfully retrieved.

4 .8 Uninstalling client software in Windows

1. Uninstall the Creo Color Server Job Ticket software:Start >

Program > Creo Color Server > Creo Color Server JT >

Uninstall V1_0

2. Uninstall the Remote Site Manager software:Start > Program

> Creo Color Server > Remote Site Manager > Uninstall V1_0

3. Uninstall the Print Driver software:

a. From your computer, navigate to the \\<server name>
\Utilities\PC Utilities\Driver Extension
folder on the Color Controller C-81.

b. Double-click the DEXUninstaller file.
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4 .9 Uninstalling client software in Mac OS

1. Uninstall the Creo Color Server Job Ticket software by removing

the following folders:

a. /Applications/Creo_Color_Server_Tools
b. /Library/Application Support/

Creo_Color_Server_Tools
2. Uninstall the Print Driver software.

Note: Only perform the following steps after upgrading your system to

version 1.1.

a. Exit all open applications.

b. From the Go menu, select Connect to Server.

c. In the Server Address box, type your Color Controller C-81 host

name or address, and click Connect.

d. In the Connect as area, select Guest.

e. Click Connect.

f. Select Utilities, and then click OK.

g. Select the Mac Utilities folder.

h. Double-click the CCSUninstall.dmg file.

i. Double-click the CCSUninstall.app file.

j. Close all running applications on your Mac computer, and then

click OK.

k. Select the suitable Creo printer driver, and then click OK.

l. If necessary, type your name and password, and then click OK.

m. Click OK.

The Print Driver software is removed. You can now upgrade the

Print Driver software.

Note: You will need to reinstall the network printers that you removed after

you have upgraded the software.
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5 First time setup and

configuration

5 .1 Space requirements for installing the Color

Controller C-81
Make sure that at your site there is enough space near the press for the

Color Controller C-81 installation. You need a minimum of 8 inches

(20cm) at the back and sides of the Color Controller C-81 as shown

below.

Figure 2: Space requirements for the Color Controller C-81

5 .2 Connecting and turning on the Color Controller

C-81
For more information, see the Easy Setup Steps chart supplied with your

Color Controller C-81 .

Connect the Color Controller C-81 to your printer as illustrated below.



Figure 3: Connecting the Color Controller C-81

5 .2 .1 Connecting the Color Controller C-81 to the printer

To enable communication between the printer and the Color

Controller C-81.

1. Enter the SP mode on the printer, and then select the

SP5193-001 settings (External controller info. settings).

2. Type 5, and then press the # (Enter) key.

3. Touch Exit when the message to reboot the printer appears.

Note: During the process of connecting the Color Controller C-81 to the

printer, you will need to turn the printer off and then turn it back on.

4. Turn off the printer using the main power switch that is

located behind the front cover.

5. Shut down the Color Controller C-81.
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6. Locate the printer interface cable (crossover Ethernet cable) that

was shipped with the Color Controller C-81 and connect one end of

the cable to the printer interface port on the Color Controller C-81,

and then connect the other end of the cable to the correct Ethernet

port on the printer.

Figure 4: Printer and Color Controller C-81 connection

Note: To prevent the risk of crosstalk, make sure the printer interface cable

does not touch the system’s power cables. The Color Controller C-81 could

shut down or image quality problems could result.

7. Open the Color Controller C-81 front panel and press the power

control button.

Wait approximately two minutes for the Color Controller C-81 to

reach the idle state and for the workspace to appear.

8. Turn on the printer using the main power switch.

5 .2 .2 External LEDs and controls

This section identifies the external LEDs and controls of your Color

Controller C-81 .
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Figure 5: Front door controls and indicators

The following list describes functions of the external indicator

lights and controls:

Power-on LED

Illuminates steady green when the Color Controller C-81 is

turned on

Disk activity LED

Flashes orange when a hard disk drive is in use

Power control button

Turns the Color Controller C-81 on or off

Reset button

Restarts the Color Controller C-81

USB port

Connects any USB device to the Color Controller C-81

Ethernet link status LED

Indicates an active connection on the ethernet port when

the LED is illuminated. This LED is on the ethernet

connector at the back of the server
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Ethernet transmit/receive activity LED

Indicates activity between the server and the network when

the LED is illuminated. This LED is on the ethernet

connector at the back of the server

See also:

Turning on the Color Controller C-81 on page 29

5 .2 .3 Turning on the Color Controller C-81

Before connecting the Color Controller C-81 to an AC power source,

review the safety precautions.

See also:

Safety precautions on page 3

Turning on the Color Controller C-81

1. Connect the monitor’s AC power cable to an AC power source,

and turn on the monitor.

2. Connect the Color Controller C-81’s AC power cable to the AC

power source

3. Wait 20 seconds, and then press the power control button on the

Color Controller C-81. The ON/OFF LED on the front panel

illuminates a steady green.

After the system startup is complete, the desktop appears.

4. If a power failure occurs while the Color Controller C-81 is turned

on, it will restart automatically when the power is restored.

Turning off the Color Controller C-81

Perform an orderly shutdown of the operating system before turning off

the Color Controller C-81.

1. Exit the Color Controller C-81 software.

2. On the Color Controller C-81 desktop, click Start > Shut Down.

3. In the Shut Down Windows dialog box, click OK.

4. Disconnect the AC power cable from the AC power source.

5 .3 Configuration Wizard (first-time software setup)
After turning on the Color Controller C-81 for the first time, the

Configuration Wizard appears.
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The first-time software setup is performed using the Configuration

Wizard.

Note: During the configuration process, when prompted to restart your

computer, click No. At the end of the Configuration Wizard, you will be

prompted to restart your system.

5 .3 .1 Choosing the configuration type

● Verify that First Time Configuration is selected.
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5 .3 .2 Configuring the server setup

Configuring the host name

The initial computer name (host name) and workgroup name of the

Color Controller C-81 is created automatically during the factory

installation. To change the computer name, check with your system

administrator.

1. In the Server name area, verify that the correct host name appears.

If the name is correct, proceed to Setting the date and time.

2. If you need to change the host name, click Change.

The System Properties window appears.
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Important: Do not modify the Workgroup or Domain in the following

step unless instructed to. If you do change the workgroup or domain,

verify that you have the correct user name and password for the

workgroup or domain.

3. On the Computer Name tab, click Change.

The Computer Name Changes dialog box appears.

4. In the Computer name field, type the new name for the Color

Controller C-81 . If you want to change the workgroup or the

domain in which your computer appears, type the new name

in the corresponding box, and click OK.

A message appears to inform you that changes will take effect

only after restarting the Color Controller C-81.
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5. In the System Properties dialog box, click OK.

Note: When prompted to restart your Color Controller C-81 , click No.

See also:

Setting the date and time on page 33

Setting the date and time

1. In the Date & Time area, verify that the date and time are set

correctly. If they are correct, click Next and proceed to Configuring

the network setup.

2. If the settings are not correct, click Change.

The Date and Time Properties dialog box appears.

3. If you want to change the date and time, set the correct date and

time, and then select the Time Zone tab.

4. Select the time zone in which you are located and click OK.

See also:

Configuring the network setup on page 33
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5 .3 .3 Configuring the network setup

Configuring TCP/IP addresses

1. In the TCP/IP area, verify that the IP address is correct. If the

IP address is not correct, click Change.

The Local Area Connection Properties dialog box appears.
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2. In the This connection uses the following items list, select

Internet Protocol (TCP/IP) and then click Properties.

The Internet Protocol (TCP/IP) Properties dialog box appears.

3. Select Use the following IP address.

4. In their corresponding boxes, type the new IP address, Subnet

mask,and Default gateway (if applicable).

5. Click OK.

Note: When prompted to restart your Color Controller C-81 , click No. You

will be prompted at the end of the Configuration Wizard to restart the server.

6. In the Local Area Connection Properties dialog box, click OK.

See also:

Configuring the IPv6 address on page 36
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Configuring the IPv6 address

1. In the IPv6 Address area, verify the address is correct.

2. If the settings are not correct, select the IPv6 check box to

enable IPv6 addressing. The following message appears:

You need to restart the application for the new
settings to take effect.

3. Click OK.

4. Type the new IPv6 address (get this information from the

network administrator).

5 .3 .4 Configuring the remote tools setup

The WebViewer provides server information and enables you to

view the status of jobs in the Print Queue, the Process Queue, and

the Storage area.

The Remote Workspace opens an actual workspace for the

selected server and enables you to import jobs, print jobs, and
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perform certain workflows. Several users can connect to the same

server simultaneously from different remote workstations.

1. In the WebViewer area, verify that Enable Webviewer is selected.

2. In the Remote Workspace Setup area, verify that Enable Remote

Connection is selected.

Note: You can have up to 13 remote connections.

3. To change the Logoff Automatically after parameter, enter the

number of hours.

4. Click Remote Connections Viewer, to view the remote

connections.

5 .3 .5 Configuring security settings

Using the default password settings

The Auto Log on check box is selected by default so that you don’t

have to log on to the Color Controller C-81 each time. If you want each

user to have to log on to the Color Controller C-81, you need to set the

security settings. You can assign each user an access level and

password. There are three access levels:

Operator (default)—enables the user to operate the Color Controller

C-81 and configure the Preferences area in the Preferences window

Administrator—enables the user to access all features and settings on

the Color Controller C-81
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Guest—enables the user to import a job through an existing virtual

printer and view the workspace

Note: The factory default password for Administrator and Operator users is

colorserver. It is used to log on to Windows and to connect to the Color

Controller C-81 via the Microsoft Remote Desktop Connection utility.

In the Passwords area, verify that Auto log on is selected.

Note: If you want each user to have to log on to the Color Controller

C-81, clear the Auto log on check box.

Changing the administrator password

1. In the Passwords area, clear Auto log on check box.

2. Under Administrator, in the Enter old password box, enter the

default password (colorserver).

3. In the Enter new password box, enter a new password.

4. In the Verify new password box, re-enter the new password to

confirm it and click Apply.

Changing the operator password

1. In the Passwords area, clear Auto log on check box.

2. In the Operator area, in the Enter old password box, enter the

default password (colorserver).

3. In the Enter new password box, enter a new password.

4. In the Verify new password box, re-enter the new password to

confirm it, and click Apply.

Restricting guest access

In the Passwords area, under Guest, select the Disable guest

connection check box.

Using default disk wipe setting

The Disk Wipe utility enables you to work in a more secure

environment, by permanently removing data left by files that you

have deleted. The utility eliminates the contents of your deleted

files by scanning all of the empty sectors on both the system and

image disks, and replacing them with zeros. Non-empty sectors
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are left untouched. The Disk Wipe utility starts automatically every

time you quit the Color Controller C-81 software.

In the Disk Wipe area, do one of the following:

○ To enable the Disk Wipe utility, select the Wipe disk on system

shutdown check box.

○ To disable the Disk Wipe utility, clear the Wipe disk on system

shutdown check box.

5 .3 .6 Configuring image disks
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Verify the minimum free disk space, and then perform one of

the following options:

○ If the disk space is correct, proceed to the next screen in

the wizard.

○ If you need to change the amount of free disk space, enter

the correct minimum disk space that you require.

5 .3 .7 Configuring backup and restore paths

You can back up your configuration to a local hard disk, network

drive, CD or DVD media.

The following settings can be backed up and restored:

● Server information

● Network setup

● Server resources

● System preferences
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● Color tables

● Imposition templates

In the Configuration backup area, select Browse to change the

default path.

Note: The last path is saved and displayed in the path box. If the backup is

made to external media, the displayed path is the default: C:\Color
Controller C-81\General\Configuration.

5 .3 .8 Setting the localization parameters

You configure the measurement unit, and language in the Localization

window.

1. In the Region list, select the region in which you are working.

2. In the Units list, select the required default measurement unit.

3. In the Language list, select the required interface language.
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5 .3 .9 Configuring the deletion policy

1. In the Deletion policy area, select the Automatically delete

jobs from storage check box and then select one of the

following:

○ After 30 days

○ After 12 hours

2. Enter the desired number of days or hours.

Note: Change the number of days or hours depending on your site

requirements.

3. In the Held jobs area, select the Delete held jobs after check

box, and enter the desired number of hours.

Note: A held job is one that is bypassed in the Print Queue.
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5 .3 .10 Configuring the pre-RIP preview

1. In the PostScript preview area, specify the desired action when

you close the Adobe Acrobat preview window:

● Save file as PDF

● Return to the original PostScript file

2. In the VDP jobs preview area, select the desired number of

booklets that you want to preview before the job is processed.
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5 .3 .11 Configuring the queues manager

You will need to install the dongle included in the Process Power

Kit to activate this feature.

1. In the Job batching policy area, select one of the following:

○ Select Enable job batching to print jobs that have similar

attributes one after the other without having the printer

pausing in between jobs.

○ Select Disable job batching to discontinue printing jobs

that have similar attributes and enable the printer to pause

in between printing jobs.

2. In the Held jobs policy area, select one of the following:

○ Select Bypass held jobs to bypass held jobs in the Print

Queue.

Note: This option moves the next job to the top of the Print Queue

and saves valuable production time.

○ Select Don't bypass held jobs to stop printing from the

Print Queue when a job is assigned a held status.

Note: This option preserves the original order of the files in the

queue.
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5 .3 .12 Configuring messages

By default, all jobs that were handled during the past 90 days are listed

in a log in the Accounting Viewer. You can determine how long

information remains before it is overwritten.

In the Accounting log setup area, enter the number of days after

which you can overwrite messages, if different than 90 days.

Configuring JDF output and JMF signals 45



5 .3 .13 Configuring JDF output and JMF signals

The Color Controller C-81 receives the JDF job ticket via hot

folders, returns JDF output with job accounting information, and

submits JMF (Job Messaging Format) signals with the job's status.

If the JDF job has a target path specified in the job, JDF output is

always created. For JDF jobs that do not have a specified target

path, the JDF output is only created if this option is selected in the

Configuration Wizard.

1. In the JDF outputs area, select the Create JDF outputs check

box, and select one of the following options:

● Select All jobs to create JDF reports for all jobs.

● Select Only source JDF jobs to create JDF reports from

only source JDF jobs.

2. In the Target path box, type the target path or click Browse to

locate the directory for the JDF output.

3. In the JMF signals for job status area, select the Send JMF

signals check box to receive JMF signals about the job’s

status.

4. In the HTTP URL box, type HTTP URL . This enables you to

submit JMF signals with the job status each time that the job

status of a job in the system changes.
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5 .3 .14 Configuring general defaults

1. In the Default Image Size area, select the desired size.

When a PDL file does not contain page size information, the RIP

uses a predefined default size. This default size is defined

according to the unit of measurement that you have selected

during the first-time configuration.

2. In the OPI area, select the following options if you want to

automatically create a low-resolution image of Do not use to make

a claim that isn't substantiated by data. supported file formats for

placement in any layout application:

a. Select the Enable OPI support check box.

b. Select the Support Helios Server check box if you receive files

that were created by the Helios OPI Server.

OPI Support automatically creates a low-resolution image of Do

not use to make a claim that isn't substantiated by data. supported

file formats for placement in any layout application. It replaces

layout images on-the-fly with optimized high-resolution images

during output.

By default, the OPI support option is not active.

3. In the Default archive path area, choose this option if you want to

set a default path in which to archive jobs:

a. Click Browse and locate the folder in which you want to archive

jobs.
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4. In the Job title recognition area, select one of the following

options:

○ Use PostScript Internal name (Use when spooling from

Mac OS X): Uses the internal file name as written inside

the PostScript file by the print driver (default)

○ Use files name (Use when printing via LPR): Uses the job’s

given file name. Selecting this option ensures that the job

appears in the Color Controller C-81 with the name last

given by the user.

5. In the Cache global VDP elements area, select the Always

cache global VDP elements check box to cache and store VDP

elements for reuse.

6. Select the Offset between jobs check box to offset between

jobs.

5 .3 .15 Completing the configuration

After the installation is complete, the Configuration Completed

window appears.

1. Click Finish.

The configuration settings are automatically backed up.
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After a few moments, the Color Controller C-81 workspace

appears on your screen.

2. Exit the Color Controller C-81 software. If you made any changes

to the configuration, these changes will only take effect if the Color

Controller C-81 is shut down and then restarted.

3. Quit any other software that may be running, and from the

Windows Start menu, select Shut Down > Restart > OK. After

restarting, the Color Controller C-81 software splash screen

appears.

Note: Make sure to turn off the printer before you restart the Color Controller

C-81. After the Color Controller C-81 restarts and the workspace appears,

you can turn on printer.

4. The Color Controller C-81 software is automatically loaded and

launched.

A backup of the operating system should be performed after the

system configuration is completed.

See also:

Backing up system partition C on page 62

5 .4 Configuring McAfee VirusScan
Anti-virus software is not included on your Color Controller C-81 . It is

recommended that you install McAfee VirusScan software on your

Color Controller C-81 . After installing VirusScan software, perform the

following configuration procedures.

Important: Running VirusScan software could slow down process time and affect

the overall performance of the server.

Once a year, the site manager must obtain the latest version of the

antivirus software and installation procedure. The site manager must

also regularly download the latest antivirus definitions from the

relevant Internet site.

Note: The following VirusScan software configuration procedure is subject to

change without notice, and the relevant documentation may not be updated.
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5 .4 .1 Configuring the Full Scan settings

1. From the taskbar, right-click the VShield icon and select

VirusScan Console.

2. In the Task column, right-click Full Scan and select Properties.

3. Click the Detection tab.
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4. In the What not to scan area, click Exclusions.

5. Click Add.

6. Click Browse.

7. In the Browse for Folder window, locate the D:\Output folder

and click OK.

The D:\Output path appears.
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8. Select the Also exclude subfolders check box, and click OK.

9. In the Set Exclusions dialog box, click OK, and then click OK

again.

5 .4 .2 Configuring the On-Access Scan settings

1. Return to the VirusScan Console window.
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2. Double-click the On-Access Scanner icon.

3. In the left pane, click the All Processes icon.

4. Select the Detection tab.
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5. In the What not to scan area, click Exclusions.

6. In the Set Exclusions dialog box, click Add.

7. Click Browse.

8. In the Browse for Folder window, locate the D:\Output
folder and click OK.

The D:\Output path appears.
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9. Select the Also exclude subfolders check box, and click OK.

10. In the Set Exclusions dialog box, click OK.

11. In the VirusScan On-Access Scan Properties window, click OK.

12. To activate the antivirus software, restart the Color Controller

C-81.

5 .5 Performing a test print and color image check

5 .5 .1 Importing a file and performing a test print

1. From the File menu, select Import.

2. Locate one of the following files:

○ Golfer_Letter.pdf in the

D:\Sample_Files\Print Samples\Samples Europe
(A3-A4)

○ Golfer_A4.pdf in the

D:\Sample_Files\Print Samples\Samples US
(DLT-LTR)

3. Double-click the file to add it to the list for importing.

4. Select the Print virtual printer.

5. Click Import.

The file is processed, printed, and sent to the Storage area.
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Note: If the job does not print or is waiting in the Print Queue, make sure

that the default virtual printer parameters are set to the current finishing

device. (Job Parameters > Finishing).

5 .5 .2 Importing a file and performing a color image check

1. From the File menu, select Import.

2. Locate one of the following files:

○ Letter_Color Test Chart.pdf in the

D:Sample_Files\Color Files\Color Test
Chart

○ A4_Color TEST Chart.pdf in the

D:Sample_Files\Color Files\Color Test
Chart

3. Double-click the file to add it to the list for importing.

4. Select the Print virtual printer.

5. Click Import.

The file is processed, printed, and sent to the Storage area. All

color patches should be visible. Each color’s patch set should

show uniform gradation from patch to patch as the color

lightens from 100% to 0%.

6. Check that each 100% patch has a solid color and that there

are no imperfections (not blotched or scratched).

7. Check that the density difference between the 60% patch and

50% patch is clearly visible.

8. If a problem appears on the test print, perform the following

steps:

● For solid color problems, on the printer control panel, enter

the SP mode, and then execute the process control with

SP3-820-002.

● For density difference problems, perform color calibration

on the Color Controller C-81.

Note: If the job does not print or is waiting in the Print Queue, make sure

that the default virtual printer parameters are set to the current finishing

device. (Job Parameters > Finishing).
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6 Reinstalling the Color

Controller C-81 software

6 .1 When to reinstall software
This chapter describes the installation procedures for the Color

Controller C-81. It describes how to reinstall the operating system, and

how to reinstall the Color Controller C-81 software.

If you are upgrading an existing site or reinstalling, it is essential to

capture and save all critical information before starting the installation

procedure. This information could be lost if it is not saved to an external

device or network in the event of a system crash.

The installation is mostly unattended. User interaction is needed only

for entering the computer hostname, for restarting the computer when

requested, and for inserting DVD 1 and DVD 2.

There are three methods for reinstalling the system:

● Complete installation (overwrite all existing data)—This procedure

requires two discs, DVD 1 and DVD 2. It installs a clean system with

the Color Controller C-81 software and recreates C and D partitions.

The Complete installation overwrites the operating system.

Perform this installation under the following conditions:

○ When installing a new operating system

○ When physically replacing a system disk

○ When upgrading from non-RAID to RAID

○ After an unrecoverable system crash

● Preservation installation (overwrite system partition only)—This

procedure requires two discs, DVD 1 and DVD 2. It installs the Color

Controller C-81 software and formats only the operating system

partition. In other words, partition C is recreated, and the information

on partition D is preserved and not deleted.

Perform this installation under the following conditions:

○ When the Windows XP operating system is corrupt and needs to

be reinstalled

○ After an unrecoverable system crash

○ When you are upgrading the operating system

● System backup and restore—This procedure only requires DVD 1. It

is the fastest method in which to reinstall the system drive. Use this

procedure if you have the latest software version and software



updates installed, and you want to keep an image file that can

be restored later on.

Note: A non-RAID configuration cannot be restored on a RAID

configuration. Before performing the backup and restore procedures,

make sure that your computer's configuration is the one that you want to

use when restoring the system.

Perform this installation under the following conditions:

○ After an unrecoverable system crash

○ When the Windows XP operating system is corrupt and

needs to be reinstalled

6 .2 Installing the operating system and software
The following steps summarize the procedures you must perform

before and after you reinstall. Before you start, review the steps to

familiarize yourself with the procedures. You can also use the

steps as a check list to verify that you have completed all the

required procedures.

1. Archive any important customer jobs to an external device.

2. Back up the system configuration from the Configuration

backup in the Preferences window .

3. Reinstall the operating system (Windows XP) and Color

Controller C-81 software (Complete installation or Preservation

installation).

4. Use the configuration wizard. If backup is available, use the DFE

Configuration Recovery. If no backup is available, use the First

Time Configuration.

5. Install and configure virus protection software (highly

recommended).

6. Perform a test print.

7. Restore customer jobs.

8. Restore your system configuration from the Configuration

backup in the Preferences window .

9. Back up the Color Controller C-81 system partition (System

backup and restore).

Note: Check if any Creo supported software is loaded on the Color Controller

C-81. Such software must be reloaded after the Complete Overwrite

installation is completed.

Before reinstalling, ensure that:
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● All external devices are disconnected from the Color Controller C-81

● The following is available:

○ Software pack (DVD 1, DVD 2)

Note: DVD 1, which includes the operating system, does not require

entering a license number or activation.

○ Computer name

○ TCP/IP information

○ Gateway, WINS address, and DNS information (if DHCP is not

active on site)

1. If the Color Controller C-81 is on and the workspace is open:

a. Exit the workspace.

b. Place DVD 1 into the DVD-RW drive.

c. From the Windows Start menu, select Shut Down > Restart >

OK.

The Color Controller C-81 restarts and then the Creo Color

Server startup menu appears.

Creo Color Server startup menu
==============================
1)    Complete installation (overwrite all 
existing data)
2)    Preservation installation (overwrite 
system partition only)
3)    System backup and restore
4)    Firmware setup 
5)    Exit
Select an option [1, 2, 3, 4 or 5]:
Proceed to step 3 on page 18
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2. If your Color Controller C-81 is off:

a. Press the Power On/Off button on the front panel.

b. As soon as power is applied, place DVD 1 into the DVD-

RW drive.

The Creo Color Server startup menu appears.

Creo Color Server startup menu
==============================
1)    Complete installation (overwrite 
all existing data)
2)    Preservation installation 
(overwrite system partition only)
3)    System backup and restore
4)    Firmware setup 
5)    Exit
Select an option [1, 2, 3, 4 or 5]:

3. Press the number of the option that you want to perform:

○ To perform a complete installation, ,press 1.

○ To perform a preservation installation, press 2.

4. Press y (Yes) to confirm your selection.

Note: Pressing n (No) returns you to the Creo Color Server startup

menu menu.

The system starts copying the files. The copying process takes

about ten minutes.

5. When the process is complete, remove DVD 1 from the DVD-

RW drive, and press Enter to restart

6. In the Computer Name and Administrator Password screen,

type the name for the Color Controller C-81—for example,

C81_WinXP.

Important: In the Administrator Name and Password area, use the

default settings.If required, you can change the administrator name and

password, but only at the end of the installation process.

7. Click Next.

The system restarts and the Color Server Installation window

appears.

8. When the License Agreement window opens, click Yes to

continue the Color Controller C-81 installation.

9. When the installation is complete:

a. Click Finish to restart the computer.

b. Remove DVD 2 from the DVD-RW drive.

When the application starts the following message

appears.
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c. Click OK.

Note: If the Wrong Disk Configuration message appears after

you restart the computer, the disks need to be configured for RAID.

d. Continue with the Configuration Wizard (First-time Software

Setup).

See also:

Archiving jobs on page 16

Retrieving jobs on page 22

Configuration Wizard (first-time software setup) on page 29

Configuring security settings on page 37

Configuring McAfee VirusScan on page 49

Performing a test print and color image check on page 55

Backing up system partition C on page 62

Recreating a volume on page 133

6 .3 System partition backup and restore
Back up the Color Controller C-81 system partition so that you always

have a working copy of your software to be able to restore your system,

if necessary.

For best results, back up the system partition each time you update the

Color Controller C-81 software, update the system cofiguration,

perform a complete installation, or update the operating system.

There are two methods of system partition backups:

● Back up and restore system partition C—Norton Ghost software

copies the files on partition C to an image file on partition D, and

restores partition C from the image file on partition D.

● Back up and restore system partitions C and D—Norton Ghost

software copies the files on partitions C and D to a DVD and

restores partitions C and D from the backup.
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Notes:

● Jobs located in the queues and the Storage area are not backed up.

● Before performing the backup and restore procedures, make sure that

your computer’s configuration is the one that you want to use when

restoring the system.

● It is recommended that you delete unnecessary files, such as temporary

files, and all jobs in the workspace before performing the backup

procedure.

6 .3 .1 Backing up system partition C

If you are already logged onto your system and the Color

Controller C-81 workspace is open, exit the workspace, insert DVD

1 into the DVD-RW drive, and proceed to step 3 on page 62.

1. Turn on your Color Controller C-81.

2. Place DVD 1 into the DVD-RW drive.

3. Restart the Color Controller C-81.

The Creo Color Server startup menu appears.

Creo Color Server startup menu
==============================
1)    Complete installation (overwrite all 
existing data)
2)    Preservation installation (overwrite 
system partition only)
3)    System backup and restore
4)    Firmware setup 
5)    Exit
Select an option [1, 2, 3, 4 or 5]:

4. Press 3 to use the System backup and restore.

The System backup and restore menu appears.

Tip: If you want to copy the files to an external device, copy only the files

located on D:\Backup that begin with SYSPART.

5. To back up system partition C, press 1. This option backs up

the files on partition C to an image file on partition D.

6. When the Caution message appears press y to proceed.

The Norton Ghost window appears.
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7. If a Norton License Agreement window appears, click OK to

continue.

Symantec Norton Ghost copies the files on partition C to an image

file on partition D. The process takes about 8 minutes to complete.

8. When the backup is complete, press Enter to return to the

System backup and restore menu.

Note: If an error message appears, press Enter to return to the System

backup and restore menu to repeat the procedure.

6 .3 .2 Restoring system partition C

Important: For best results, always disconnect the network cable before installing

software.

The Color Controller C-81 enables you to restore partition C or the

entire system (partitions C and D). Restore the software on your Color

Controller C-81 after an unrecoverable disk crash, or when the system

exhibits unpredictable behavior—for example, error messages

suddenly appear or occasional the user interface freezes. The process

takes 20 - 30 minutes, depending on the size of the partition.

Performing the restore procedure requires a previous backup.

1. Exit the Color Controller C-81 work space.

2. Insert DVD 1 (Windows XP operating system) into the DVD-RW

drive.

3. From the Windows Start menu, select Shut Down > Restart > OK.

The Creo Color Server startup menu appears.

Creo Color Server startup menu
==============================
1)    Complete installation (overwrite all 
existing data)
2)    Preservation installation (overwrite 
system partition only)
3)    System backup and restore
4)    Firmware setup 
5)    Exit
Select an option [1, 2, 3, 4 or 5]:

4. Press 3 to use the System backup and restore.
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5. To restore only partition C, press 2. This option restores

partition C from the image file on partition D.

Note: Before restoring the color server system partition, you may need

to return the ghost file or files that you moved to an external device to

D:\Backup.

WARNING: The restore procedure erases all data on your system

partition C.

6. Press y to continue.

The Norton Ghost window appears and the image file on

partition D is restored to partition C.

7. When the restore process is sucessfully completed, remove

the DVD from the DVD-RW drive and press Enter to

continue.

The computer restarts automatically.

6 .3 .3 Backing up system partitions C and D

If you are already logged onto your system and the Color

Controller C-81 workspace is open, exit the workspace, insert DVD

1 into the DVD-RW drive, and proceed to step 3 on page 62.

1. Turn on your Color Controller C-81.

2. Place DVD 1 into the DVD-RW drive.

3. Restart the Color Controller C-81.

The Creo Color Server startup menu appears.

Creo Color Server startup menu
==============================
1)    Complete installation (overwrite all 
existing data)
2)    Preservation installation (overwrite 
system partition only)
3)    System backup and restore
4)    Firmware setup 
5)    Exit
Select an option [1, 2, 3, 4 or 5]:

4. Press 3 to use the system backup and restore.

5. To back up the entire system (partitions C and D), press 3.

This option backs up partitions C and D on to DVD media. You

may need more than one DVD for the backup.

6. When the Backup C and D partitions on DVD message

appears press y.
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7. Place a DVD into the DVD-RW drive.

8. Press Enter to continue.

Norton Ghost copies the files on partitions C and D to the DVD.

Note: If an error occurs during the backup process, a message appears asking

you to contact customer support. Press any key to continue and the Color

Controller C-81 restarts automatically.

9. When a confirmation message appears notifying you that the

backup process was successfully completed, remove the DVD

from the DVD-RW drive and press Enter to continue.

The Color Controller C-81 restarts automatically.

6 .3 .4 Restoring system partitions C and D

Important: For best results, always disconnect the network cable before installing

software.

The Color Controller C-81 enables you to restore partition C or the

entire system (partitions C and D). Restore the software on your Color

Controller C-81 after an unrecoverable disk crash, or when the system

exhibits unpredictable behavior—for example, error messages

suddenly appear or occasional the user interface freezes. The process

takes 20 - 30 minutes, depending on the size of the partition.

Performing the restore procedure requires a previous backup.

1. Exit the Color Controller C-81 work space.

2. Insert DVD 1 (Windows XP operating system) into the DVD-RW

drive.

3. From the Windows Start menu, select Shut Down > Restart > OK.

The Creo Color Server startup menu appears.

Creo Color Server startup menu
==============================
1)    Complete installation (overwrite all 
existing data)
2)    Preservation installation (overwrite 
system partition only)
3)    System backup and restore
4)    Firmware setup 
5)    Exit
Select an option [1, 2, 3, 4 or 5]:

4. Press 3 to use the System backup and restore.
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5. To restore partitions C and D, press 4. This option restores

partitions C and D from DVD media.

WARNING: The restore procedure erases all data on your system

partition C and D.

6. Press y to continue.

7. Place a DVD into the DVD-RW drive, and then press Enter
to continue.

Norton Ghost software copies the files on the DVD to partitions

C and D.

8. When the restore process is successfully completed remove

the DVD from the DVD-RW drive and press Enter to

continue.

The computer restarts automatically.
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7 Diagnostics and

troubleshooting

7 .1 Platform diagnostics and configuring the server
This section provides basic troubleshooting information to help you

resolve some issues that might possibly occur with the Color Controller

C-81.

To maintain the good health of the server, it is important that the server

continuously remains correctly configured. An incorrectly configured

server will deliver poor performance, and the diagnostic results will be

adversely affected.

7 .1 .1 Configuring tools overview

The following configuration programs are also provided to assist you in

configuring the server, and to provide diagnostic information:

● BIOS Setup Utility

● Gigabit Ethernet Controller

● LAN speed verification

BIOS

This program controls the basic input/output system (BIOS) code in

your server. Use the BIOS Setup Utility to:

● View configuration information.

● View and change assignments for devices and I/O ports.

● Set the date and time.

● Set the startup characteristics of the server and the order of startup

devices.

● Set and change settings for advanced hardware features.

● View and clear error logs.

● Resolve configuration conflicts.

Gigabit Ethernet Controller

The Ethernet controller is integrated on the system board.

● It provides a interface for connecting to a 10-Mbps, 100-Mbps, or

1000-Mbps network and provides full duplex (FDX) capability,



which enables simultaneous transmission and reception of data

on the network.

● If the Ethernet port in the server supports auto-negotiation, the

controller detects the data-transfer rate of the network

(10BASE-T, 100BASE-TX, or 1000BASE-T) and automatically

operates at that rate, in full-duplex or half-duplex mode, as

appropriate.

● The Ethernet controller supports optional modes, such as

teaming, priority packets, load balancing, fault tolerance, and

virtual LANs, which provide better performance, security, and

throughput. These modes apply to the integrated Ethernet

controller and to controllers on supported Ethernet adapters.

Troubleshooting the ethernet controller

This section provides troubleshooting information for problems

that might occur with the 10/100/1000-Mbps Ethernet controller.

To resolve network connection problems:

If the Ethernet controller cannot connect to the network, perform

the following:

○ Check the BIOS configuration relating to the LAN.

○ Verify that the cable from the LAN connector on the server is

connected to the LAN.

○ Check that the network cable is attached at all connections. If

the cable is attached but the problem persists, try a different

cable.

○ Check the LAN activity light on the rear of the Color Controller

C-81. The LAN activity light illuminates when the Ethernet

controller sends or receives data over the Ethernet network. If

the LAN activity light is off, ensure that the hub and network are

operating and that the correct device drivers are loaded.
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Verifying the LAN speed

Use the following procedure to make sure that your system is operating

at the maximum speed of the network.

1. Right-click My Network Places, and select Properties.

The Network Connection window appears.

2. Right-click Local Area Connection, and select Properties.

3. Select the Show icon in notification area when connected check

box and click OK.

4. Roll the cursor over the network icon in the taskbar to display the

speed, as shown in the following example:

7 .1 .2 Using the configuring tools

Using the BIOS setup utility

This section provides instructions for starting the BIOS Setup Utility.

Do not alter any BIOS settings unless they are different from the

recommendations in this section. Faulty BIOS settings could cause the

system to fail or to operate incorrectly. If you encounter a problem with

a hard disk, check the BIOS settings to ensure that the BIOS recognizes

the hard disk.
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Starting the BIOS setup utility

1. Quit the color server software.

2. Restart the Color Controller C-81 and immediately press

Delete.

The BIOS Setup Utility window appears.

Figure 6: BIOS Setup Utility main window

Note: The choices on some menus might differ slightly from the ones

that are described in this manual. The menu choices depend on the BIOS

version in the server.

3. Verify that the BIOS settings on the Color Controller C-81 are

as follows.
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BIOS setup utility main menu

Figure 7: BIOS Setup Utility main menu

BIOS setup utility advanced settings

Figure 8: Boot Features menu
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Figure 9: Processor and Clock Options menu

Figure 10: SATA/Floppy Configuration menu
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Figure 11: PCI/PnP Configuration menu

Figure 12: Hardware Health Configuration menu
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BIOS setup utility boot menu

Figure 13: Boot Device Priority menu

BIOS setup utility exit menu

Figure 14: Exit Options menu
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Configuring the order for hard disk drives

If you encounter a problem with the system or the BIOS, load the

default BIOS settings and then configure the order of the hard disk

drives .

1. Start the BIOS Setup Utility.

The BIOS Setup Utility window appears.

Figure 15: BIOS Setup Utility main menu

2. If required, change the system date and time and press Enter to

save any changes.

Tip: To modify any of the values, use the arrow keys to move to the required

values, and the +, -, and numbered keys to change the values.
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3. Using the arrow keys, select the Boot menu.

Figure 16: BIOS Setup Utility boot menu

4. Under Boot Settings, select Hard Disk Drives

5. Verify that the settings are the same as shown in the following

window:

Figure 17: Hard Disk Drives menu

6. If the boot order is not the same as shown above, use the

arrow keys to move the devices to the correct order

7. Select the Exit menu.

8. Using the arrow keys, select Save Changes and Exit.
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9. Select OK to save the configuration and exit the setup.

10. Press any key to continue.

See also:

Starting the BIOS setup utility on page 70

Configuring the gigabit ethernet controller

You do not need to set any jumpers or configure the controller. The

device driver that enables the operating system to address the

controller is automatically installed from DVD #1 (Fast Install SLP).

7 .2 General diagnostic tools
The following tools are available to help you identify and resolve

hardware-related issues:

● PC health monitoring

● POST (Power-On Self-Test) beep codes, error messages, and error

logs—POST generates beep codes and messages to indicate

successful test completion or the detection of a problem.

See also:

POST (Power On Self Test) on page 78

7 .2 .1 PC health monitoring

This section describes the PC health monitoring features of the system

board. The system board has an onboard system hardware monitor

chip that supports PC health monitoring.

Recovery from AC power loss

BIOS provides a setting for you to determine how the system will

respond when AC power is lost and then restored to the system. You

can choose for the system to remain powered off (in which case you

must press the power switch to turn it back on) or for it to

automatically return to a power on state. The default setting is Last

State.

Onboard voltage monitoring

The onboard voltage monitor will scan the following voltages

continuously: CPU core, +3.3V, +5V, +/-12V, +3.3V Stdby, +5V Stdby,

VBAT, HT, Memory, Chipset. Once a voltage becomes unstable, it will

give a warning or send an error message to the screen. Users can
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adjust the voltage thresholds to define the sensitivity of the voltage

monitor by using SuperoDoctor III.

Fan status monitor with software

PC health monitoring can check the RPM status of the cooling fans

via SuperoDoctor III.

CPU overheat LED and control

This feature is available when the user enables the CPU overheat

warning feature in the BIOS. This allows the user to define an

overheat temperature. When this temperature reaches this pre-

defined overheat threshold, the CPU thermal trip feature will be

activated and it will send a signal to the buzzer and, at the same

time, the CPU speed will be decreased.

7 .2 .2 POST (Power On Self Test)

When you turn on the Color Controller C-81, it performs a series of

tests to check the operation of its components and some of its

installed options. This series of tests is called the power on self test

or POST.

POST error beep codes are divided into two categories:

recoverable and terminal.

This section lists beep codes for recoverable POST errors.

POST beep codes

Beep codes are sounded in a series of beeps.

● One continuous beep with the front panel Overheat LED on

indicates that system is overheating

● One long beep and eight short beeps indicate that there is a

video configuration error.

● A repetitive long beep indicates that no memory is detected.

7 .3 Color Controller C-81 hardware diagnostics

software

The Color Controller C-81 diagnostics software is used for testing

both proprietary Creo hardware (FusionRA) and standard off-the-

shelf hardware.
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There is JOIND (Sun Java Over the Internet Diagnostics)—an Color

Controller C-81 client/server diagnostic controller—that runs locally or

over a TCP/IP connection. JOIND runs under a Windows platform

(NT/98/2000/XP) and enables local diagnostic testing of Color

Controller C-81 products with user level support.

If you encounter any problems during installation or during normal

operation of the Color Controller C-81, run the Color Controller C-81

diagnostics software to determine the cause.

The diagnostic software is located on the Color Controller C-81. The

software receives and executes test requests and returns appropriate

status responses.

A hierarchical diagnostics tree shows the FRUs (field replacement

units) that can be tested by JOIND (Color Controller C-81 diagnostics

software). You can select an individual component from the tree for

testing, run batch tests of selected components, or run a general test of

all units by selecting the DFE option.

Results appear as PASS/FAIL.

7 .3 .1 Activating the diagnostics software

Note: Only run the Diagnostics utility after you exit the Color Controller C-81

software.Wait for the Color Controller C-81 software taskbar icon to disappear

before continuing.

Quitting the Color Controller C-81 software

1. In the Color Controller C-81 workspace, click the File menu and

select Exit.

2. When the message Are you sure you want to exit the
application? appears, click Yes.

3. Right-click the Color Controller C-81 software icon in the Windows

Quick Launch toolbar and select ShutDown Color Server.
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Starting the diagnostics software

From the Windows Start menu, select Color Controller C-81 >

Color Controller C-81 Tools > Diagnostics.

The diagnostics program initializes and the DFE User

Diagnostics window appears on the screen.

See also:

The Diagnostics window on page 80

7 .3 .2 The Diagnostics window

Figure 18: DFE User Diagnostics window

The DFE User Diagnostics window is divided into four sections:

● The top section contains the Main Menu bar with five different

menu options: File, View, Control, Level, and Help.

● The next section under the Main Menu bar contains shortcut

buttons for performing the main JOIND operations.

● The third section is a monitoring area in which the progress of

the tests appears.

● The fourth section is the Diagnostics tree (on the left) which

displays boards and components to be tested. On the right, it
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displays results as Pass or Fail. The last result test performed on a

specific component or batch of components also appears.

7 .3 .3 Diagnostic software menu options

File menu

Load Quick Batch Is a predefined representative set of components to be

tested coupled with predefined tests to be run. Select

Load Quick Batch to load this set of components to be

tested.

To execute the batch test, select Load Quick Batch. A

confirmation message appears. Click OK, and then click

the Run icon.

This is not the default setting and should be used only

when a quick testing set is needed, as its name implies.

Import Log File Imports the current log file from the server to the client.

Exit Exits the application. If the application has been remotely

activated (Internet or modem), the server stays active

and ready for a new connection.

View menu

Test Log File Stores information sent by JOIND. For each executed test,

JOIND uses this file to record the date and time of execution,

the loop number, the name of the test and the test result. If

the Rerun mechanism is ON, results for all reruns are

recorded. The command opens the HTML browser for viewing

this file.

Software

Configuration

Displays the software version information of JOIND (client

and server) and of the diagnostics DDLs in an HTML file and

is displayed through the HTML browser.

Hardware

Configuration

Displays hardware information that is recorded in an HTML

file and is displayed through the HTML browser. Not

applicable in this version.

Control menu

Run Initiates a test session, after the items for testing in this

session are marked in the check boxes. When Loop Off is

selected, the test session terminates after each test has been

executed. When Loop On is selected, the loop sequence is

toggled on and the test session repeats until the loop

termination condition is reached.
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Run Until Fail Initiates a test session, after the items for testing in this

session are marked in the check boxes. When Loop Off is

selected, the test session terminates after each test has been

executed or until the first failure is detected by any test,

whichever comes first. When Loop On is selected, the test

session repeats until the loop termination condition is

reached or once a failure is detected, whichever comes first.

Level menu

User The default setting for the diagnostic testing and

operations on the diagnostic tree that provides indications

regarding faulty field replacement units (FRUs).

Help menu

Online Help Loads the HTML page that has access to all the topics

below.

JOIND

Components

and GUI

Introduction to the Color Controller C-81 Remote Support

concept and describes the JOIND components and GUI.

Activating the

JOIND

Describes the access modes Remote Support and how to

run them.

The JOIND

Main Window

Describes the JOIND main window, menus and options.

The JOIND

Menu

Options

Description of the menu and sub-menus.

POS Not applicable.

About JOIND Displays the JOIND version number and date.

Toolbar buttons

The toolbar buttons are found below the main menu bar and are

available for performing the main operations when running

diagnostics tests.

Run—initiates the command to perform a diagnostic test

running in loop or executing batch of tests.

Stop—terminates a test running in loop or executing batch of

tests. This button appears only after the Run button was

selected.

Wait—appears after the Stop button is selected or until the

current test is completed.

Loop Off—terminates the test session after each test has been

executed or until the first failure is detected. Loop Off is the

default setting when executing diagnostic tests.
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Loop On—repeats the test session until the loop termination

condition is reached.

Errors—enables you to view all failed components through the

HTML browser.

Quick Error—enables you to view failed components for a

specific test through the HTML browser.

Exit—exits the diagnostics software. Remember to stop any

tests that are running before exiting.

Help—selects specific menu options or tree nodes when help is

required.

Monitoring

The monitoring area is located below the toolbar buttons. It displays

three levels of monitoring progress:

Current Test Shows the progress of the specific test be performed.

Test Progress Shows the progress of component tests of a batch run.

Batch

Progress

Shows the progress of the entire batch being run.

7 .3 .4 Board diagnostics

This section describes the diagnostics for the Color Controller C-81

boards.

The board included in this category is the FusionRA board.

Use the JOIND diagnostic utility to test the Color Controller C-81

boards. If a board fails a test, first verify that it is properly connected

(turn off the Color Controller C-81 and check the board connections

including cables and pins; sometimes boards may become loose in the

PCI slot).

Important: Replace a board or a system component that continues to fail its

diagnostics test.

Note: Exit the Color Controller C-81 software prior to running the diagnostics

program.

FusionRA board

Testing input/output memory modules

Test the input and output memories on the FusionRA board.

Testing the FusionRA board

Test the internal electrical mechanism of the FusionRA board.
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7 .3 .5 Performing a diagnostic test

Important: Prior to activating the diagnostics software, verify that the drivers

were loaded successfully (with no error messages during driver loading).

1. Access the JOIND software.

2. Select the components for testing from the diagnostics tree, or

select DFE to test the entire tree, or select Load Quick Batch

from the File Menu.

3. Click the Loop Off button to run the tests in loop mode.

4. Click the Run button to activate the diagnostics testing.

The system performs the tests and the results appear in the

area of the diagnostics tree: Pass or Fail.

5. If there are components that fail, click the Errors button to

view all failed components or click the Quick Error button to

view a specific selected test.

See also:

Activating the diagnostics software on page 79

Diagnostics test results

This section lists the possible results of the diagnostics test and

the recovery actions.

Symptom Recovery Action

FusionRA

board fails the

test.

a. Verify that the FusionRA board is correctly seated.

b. Verify that the memory tests listed below are passed.

If one or both of these memory tests fails, replace the

failed memory module and run the test again.

c. If the FusionRA test fails again, replace the FusionRA

board.

The Input

Memory fails

the test.

a. Verify that the FusionRA board is correctly seated.

b. If the input memory fails again, replace the FusionRA

board.

The Output

Memory fails

the test.

a. Verify that the FusionRA board is correctly seated.

b. If the output memory fails again, replace the

FusionRA board.

The FusionRA

board

(inclusive of all

other related

components)

does not

appear

a. Verify that the FusionRA board is correctly seated.

b. Replace the FusionRA board.
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7 .4 Monitoring the system
The Color Controller C-81 includes Supero Doctor III server monitoring

software that provides you with dynamic information about the health

of your system. The health information page enables you to monitor

the:

● System fans’ rpm

● System voltage levels

● Temperatures of the processor and system chassis

To access the software:

From the Start menu, select Programs > SUPERMICRO > Supero

Doctor III Client > Supero Doctor lll Client.
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7 .5 Troubleshooting
The first group of troubleshooting procedures relate to the three

main situations:

● The Color Controller C-81 does not turn on.

● The Color Controller C-81 turns on, but the operating system

does not initialize.

● The Color Controller C-81 turns on, the operating system

initializes but fails to execute commands.

The next set of troubleshooting procedures relate to:

● Memory, expansion enclosure, monitor, and common problems

● Ethernet printer cable faults

● Temperature and general power checkouts

● Handling error messages

● Collecting data log files

● Formatting image disks

● Disk striping

● Remote client applications

86 Chapter 7—Diagnostics and troubleshooting



7 .5 .1 Color Controller C-81 does not turn on

Symptom Recovery Action

Color Controller

C-81 does not turn

on.

Verify that:

● The power cables are properly connected to the

Color Controller C-81.

● The electrical outlet functions properly.

● The power-on LED is illuminated.

● There are no short circuits between the system board

and the chassis.

● The memory DIMMs are correctly seated by gently

pressing them down.

Then:

a. Turn the power on and off to test the system.

b. The battery on your system board may be old. Verify

that it still supplies ~3 volts DC; if not, replace the

battery.

c. If you just installed an option, remove it and restart

the Color Controller C-81. If it turns on, you might

have installed more options than the power supply

supports.

d. Review the general power checkout.

e. If the problem remains, escalate the service call.

See also:

General power checkout on page 93

7 .5 .2 Color Controller C-81 turns on, operating system does not

initialize

In this situation it is not possible to run the JOIND diagnostics

software.

Replace the system disk.
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Symptom Recovery Action

The operating

system does not

initialize.

Verify the following:

● The SATA2 cables and the power cables are

properly connected.

● The system disk is not damaged physically.

● The boot order is correct.

To verify the boot order:

a. Restart the server.

b. Press Delete to enter the computer BIOS.

c. Use the arrow keys to select the Boot menu.

d. Under Boot Settings, select Hard Disk Drives.

e. Verify the boot order is as follows:

f. Reload the operating system

g. Replace the system disk.

7 .5 .3 Color Controller C-81 does not execute commands

In this situation it is possible to run the JOIND diagnostics

software.

Symptom Recovery Action

The FusionRA board

does not appear

when running

diagnostics.

a. Verify that the FusionRA board is correctly

seated.

b. Replace the input memory located on the

FusionRA board.

c. Replace the FusionRA board.

A disk is not

functioning

properly.

a. Check that the disk is correctly installed.

b. Verify that each SATA2 cable is connected to

the correct disk and system board connector.

c. Verify that the voltage cable to each disk is

securely connected.

Several tests fail as

a result of a

particular failure.

When there is a memory failure replace the

FusionRA board and run tests on the board again.

See also:

System board internal cable connectors on page 114
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7 .5 .4 Memory problems

Symptom Recovery Action

The amount of

memory displayed is

less than the amount

of memory installed.

Verify that:

a. The memory modules are seated properly.

b. You installed the correct type of ECC DDR3

memory.

c. If you changed the memory modules, they are

installed on the system board in DIMMs 1A and 2A.

Do not use any other DIMM banks.

d. Check for faulty DIMM modules or slots by

swapping a single module between two slots and

noting the result.

e. Check that the 115/230 V power-supply switch is

correctly set.

f. If the memory tests fail, replace the failing DIMM or

contact your service representative.

See also:

Installing a DIMM on page 113

7 .5 .5 Monitor problems

Symptom Recovery Action

The Color Controller

C-81 monitor is

blank.

Verify that:

a. The power cord is plugged into the Color Controller

C-81 and a working electrical outlet.

b. The monitor cables are connected properly, including

the AC adapter.

c. The monitor is turned on and the brightness and

contrast controls are adjusted correctly.

d. Connect the monitor to a portable workstation to

check its working status. If the problem persists,

replace the monitor with a confirmed working

monitor. If this monitor works, replace the original

monitor.

e. If the power is on and there is still no video, remove

all the add-on adapters and cables, and use the

speaker to determine if any beep codes exist.

f. If the problem persists and the screen remains blank,

contact your support person.
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7 .5 .6 Common problems

Symptom Recovery Action

During installing

the operating

system, you see a

blue screen.

a. Restart the Color Controller C-81

b. If you just installed an option, remove it and restart

the Color Controller C-81.

An image disk is

not identified.

Check the following:

● SATA2 cable and power cable.

● The disk is mounted correctly in the disk bay. If the

problem persists, replace the disk.

Wrong disk
configurati
on message

appears or files

fail to RIP.

a. Open the Disk Management window.

b. If the image disk volume is not displayed, the

volume is corrupt and must be recreated.

c. To create the image volume, choose 1. Create

RAID Volume and press Enter.

d. Press Enter to choose the volume name.

Note: It is recommended that you choose the

default volume name.

e. Press Enter to choose the default RAID Level

(RAID0(Stripe).

f. Press Enter to choose the Strip Size (128KB).

g. Press Enter to choose the Capacity (931.5 GB).

h. Press Enter to create the specified volume. A

message appears warning you that all data on the

selected disks will be lost.

i. Type y to continue. The volume is created and

added to the list of RAID volumes and the

individual disks in the volume are indicated as

being a member of that volume.

j. Proceed to Formatting image disks.

The system disk

cannot be

identified.

Check that the power cable and the SATA2 cable are

properly connected to the disk and the motherboard.
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Symptom Recovery Action

The DVD-RW

drive is not

identified.

● Restart the Color Controller C-81 and press Del to

enter the BIOS Setup Utility.

a. Use the arrow keys to select the Advanced

menu.

b. Under Advanced Settings, select SATA/

Floppy configuration and verify the following

settings:

● If the problem persists, check that the SATA cable

and the power cable are firmly situated in the Color

Controller C-81.

● If the above mentioned items are working, replace

the DVD-RW drive.

The system’s

setup

configuration is

lost.

The battery on your system board may be old. Verify

that it still supplies approximately 3 volts DC; if not

replace the battery. If this does not help, escalate the

service call.

See also:

Color Controller C-81 turns on, operating system does not

initialize on page 87

Formatting image disks on page 96

Removing a hard disk drive on page 131

Installing a hard disk drive on page 132

7 .5 .7 Color Controller C-81 to data cable and ethernet printer cable

faults

The Color Controller C-81 is connected to your printer with two open I/

F cables and one crossover ethernet cable. These cables carry the

following data and configuration details between the server and printer:

● Information on your printer’s power condition

● CMYK data
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Symptom Recovery Action Further Action

(if printing fails)

General a. Shut down your printer and the

Color Controller C-81.

b. Check that the Ethernet printer

cable is securely connected to the

Color Controller C-81 port.

c. Start the server.

d. Wait until the Color Controller

C-81 splash screen disappears.

e. Start your printer.

If printing fails,

refer to the next

symptom.

Before you

print, the

printer

animation

shows green

indicating that

the printer is

ready. After

sending the

job, the

printer

appears to be

warming up

but does not

print.

a. Check if the Print Queue is in

Enable mode.

b. Check if there is no alert message

that indicates that a different

paper size or type is required.

c. Check that there is no error

message on your printer’s user

interface.

d. Shut down your printer.

e. Replace the Ethernet printer cable.

f. Start your printer.

g. Send a print job.

No communi-

cation after

following the

correct

startup

procedure.

a. Restart both your printer and the

Color Controller C-81 according to

the startup procedure.

b. Send a print job.

Job printed

with one color

overlay, or

printed output

results appear

with

scratches

(white lines)

in one of the

CMYK color

combinations.

a. Shut down both the Color

Controller C-81 and your printer.

b. Check that the Ethernet printer

cable is connected to the Color

Controller C-81 port.

c. Start the server and wait until the

Color Controller C-81 splash

screen disappears.

d. Start your printer.

e. Send a print job.

If printing fails

with color

overlay:

● Replace the

Ethernet

printer cable.

● If the

procedure

does not

solve the

problem, it

could be a

FusionRA

board

problem.

See also:

Connecting and turning on the Color Controller C-81 on page 25
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7 .5 .8 General power checkout

Power problems can be difficult to troubleshoot. For instance, a short

circuit can exist anywhere on any of the power distribution buses.

Usually a short circuit causes the power subsystem to shut down

because of an over-current condition.

A general procedure for troubleshooting power problems is as follows:

1. Turn off the Color Controller C-81 and disconnect the AC power

cord(s).

2. Check for loose cables in the power subsystem. Also check for

short circuits. For example, if there is a loose screw causing a short

circuit on a circuit board.

3. Remove adapters and disconnect the cables and power connectors

to all internal and external devices until the Color Controller C-81 is

at the minimum configuration required for operation.

4. Reconnect the AC power cord and turn on the Color Controller

C-81. If the Color Controller C-81 starts successfully, replace

adapters and devices one at a time until the problem is isolated. If

the Color Controller C-81 does not turn on from the minimum

configuration, replace the FRUs of the minimum configuration one

at a time until the problem is isolated.

7 .5 .9 Temperature checkout

Accurate cooling of the system is important for proper operation and

system reliability.

Confirm the following:

● Each of the drive bays has either a drive or a filler panel installed.

● The cover is in place during normal operation.

● There is at least 200 mm (8 inches) of ventilated space at the sides

of the Color Controller C-81 and 200 mm (8 inches) of space

around the front and rear of the server.

● The cover is removed for no longer than 30 minutes while the Color

Controller C-81 is operating.

● The fans are operating correctly and the air flow is good.

● A failed fan is replaced within 48 hours.
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7 .5 .10 Error messages

There are four types of error messages:

● System

● Hardware

● Software

● Connection

Each error message indicates a problem and sometimes also a

recovery action. If the problem is not resolved after performing the

recovery action, perform a diagnostics test and replace the

problematic part.

The following tables contain examples of different error messages.

System error messages

Message Recovery Action

System error. Reboot
the system.

● Restart the Color Controller C-81

from the Start menu.

● If the error message reappears,

run the diagnostics test.

.System error. Reinstall
the Color Controller
C-81 application

Reinstall the Color Controller C-81

software, and restart the system.

Hardware error messages

Message Recovery Action

FusionRA load failure.
Reboot the system.

● Check that the FusionRA board is

seated correctly and restart the

Color Controller C-81

● Run the diagnostics test.

● If the error message still appears,

replace the board.

Software error messages

Message Recovery Action

Failed to spool
the file during
job submission

Check the image disk space and free disk space,

if required.
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Message Recovery Action

Failed to locate
the thumbnail
for element
<name of
element> in the
job <job name>

Repeat the RIP process.

Wrong striping
configuration—
reboot the
computer and
configure the
striping

Re-create striping.

Connection error messages

Message Recovery Action

Ethernet
connection
failure

● Check the cable connections.

● Restart the client workstation computer and the

Color Controller C-81

● Check the communication parameters in the

client workstation computer and the Color

Controller C-81.

7 .5 .11 Collecting data log files

Troubleshoot a problem in the system by collecting log files from the

Color Controller C-81 software and sending the log files to a service

representative.

1. Shut down the Color Controller C-81 software.

2. From the Windows Start menu, select Color Controller C-81 >

Color Controller C-81 Tools > Data Logs Collection.
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3. The .cab file is automatically saved in a default location in

drive D. If you want to save the .cab file to another location,

click Browse, select the new location, click Save, and then OK.

4. Restart the Color Controller C-81 software.

5. Recreate the problem you encountered, and then click STOP.

The Color Controller C-81 software closes automatically and

the log files are saved in the defined location.

6. Send the Data_logs.cab file to your service representative.

7 .5 .12 Formatting image disks

Perform the following procedure when suggested as a recovery

action.

Important: Formatting erases all data stored in the Storage area. It is

recommended to back up your data, if possible, to an external device or

network.

1. Close the Color Controller C-81 software, and wait until the

server icon on the taskbar disappears.

2. From the Windows Start menu, select Color Controller C-81 >

Color Controller C-81 Tools > Format Image Disks.

3. Close all open windows, if required, and click OK.

Note: When performing the formatting procedure, all disks are

formatted including the Creo File System.
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4. Click OK.

5. Click Yes.

6. Click OK.

7. To enable the changes to take effect, restart your Color Controller

C-81.

7 .5 .13 Remote client applications

Problems with remote client applications should be reported to the

manufacturer. When reporting such issues, you should include the

released version details of the problematic remote client application.

You can find details of the released version of the remote client

application as follows:

Remote client

application

Where to find the released version details

Print driver

software (DEX)

● Windows:

○ In the Config.xml file located in the following

path: %appdata%
\Color_Server_Client_Tools
\PrinterDriver\C81CREO
\Configuration, find the released version

details in the "ReleasedVersion" group:

<GROUP NAME="ReleasedVersion">
<PARAM NAME="version" IT="STR">C-81
v1.1</PARAM> </GROUP>

● Mac

○ Right-click <InstallationDisk>\Library
\Printers\Creo_Color_Server_Tools
\JA\C81CREO.app and select Get Info. You will

find the released version details in the version field.
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Remote client

application

Where to find the released version details

Creo Color Server

JT (JTC)

● Windows:

○ In the AppInfo.xml file located in the following

path: %programfiles%
\Color_Server_Client_Tools
\Creo_Color_Server_JT\V1_0, find the

released version details in the

"ReleasedVersion" group: <GROUP
NAME="ReleasedVersion"> <PARAM
NAME="version" IT="STR">C-81 v1.1</
PARAM> </GROUP>

● Mac

○ Right-click <InstallationDisk>
\Applications
\Creo_Color_Server_Tools\Creo_JT
\V1\JTCreator.app and select Get Info. You

will find the released version details in the version

field.

Remote

Workspace

(RWSP)

● Windows:

○ In the AdditionalInfo.xml file located in the

following path: %allusersprofile%
\Color_Server_Client_Tools
\Remote_Workspace\Program_Files
\C81CREO_V1_0, find the released version

details in the "ReleasedVersion" group:

<GROUP NAME="ReleasedVersion">
<PARAM NAME="version" IT="STR">C-81
v1.1</PARAM> </GROUP>

Remote Site

Manager (RSM)

● Windows:

○ In the AdditionalInfo.xml file located in the

following path: %programfiles%
\Color_Server_Client_Tools
\Remote_Site_Manager\V1_0, find the

released version details in the

"ReleasedVersion" group: <GROUP
NAME="ReleasedVersion"> <PARAM
NAME="version" IT="STR">C-81 v1.1</
PARAM> </GROUP>
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Remote client

application

Where to find the released version details

Office Hot Folders

(OHF)

● Windows:

○ In the AppInfo.xml file located in the following

path: %programfiles%
\Color_Server_Client_Tools
\Office_HF\V1.00, find the released version

details in the "ReleasedVersion" group:

<GROUP NAME="ReleasedVersion">
<PARAM NAME="version" IT="STR">C-81
v1.1</PARAM> </GROUP>
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8 Hardware and

maintenance repairs

8 .1 System components
The following diagram shows ths system components for the Color

Controller C-81.

Figure 19: Color Controller C-81 system components

System component Description

1 System board



System component Description

2 DVD-RW drive

3 Front fan

4 Hard disk

5 FusionRA board

6 Rear fan

7 Power supply

8 Front panel

8 .2 Before you begin
Before you begin to replace parts:

● Familiarize yourself with the safety and handling guidelines

specified at the beginning of this book. These guidelines will

ensure your safety while working with the Color Controller C-81

and its options.

● Ensure that you have an adequate number of properly grounded

electrical outlets for the server, monitor, and any options that

you intend to install.

● Back up all important data before you make changes to disk

drives.

● Have both a cross-head and a small flat-blade screwdriver

available.

WARNING: Before performing any hardware maintenance or repair, turn off

the Color Controller C-81 and all peripheral devices. Disconnect all external

cables and power cords.

See also:

Safety precautions on page 3

8 .2 .1 System reliability considerations

To help ensure proper cooling and system reliability, verify that:

● The side cover is in place during normal operations.

● There is space around the Color Controller C-81 to allow its

cooling system to work properly. Leave about 127 mm (5 in.) of

space around the front and rear of the server.
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● Cables for optional adapters are routed according to the instructions

provided with the adapters.

● A failed fan is replaced as soon as possible, to prevent possible

damage to the boards.

8 .2 .2 Hardware connections

The following diagram shows the hardware connections for the Color

Controller C-81.

Figure 20: Hardware connections for Color Controller C-81

8 .3 Removing and replacing the side cover and front

panel
This section describes the procedures used to remove and replace the

Color Controller C-81 cover and front panel.

Tip: When installing options in the Color Controller C-81, you may find it easier to

place the server on its side.
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8 .3 .1 Removing the side cover

1. Turn off the Color Controller C-81 and all peripheral devices.

2. Disconnect all external cables and power cords.

3. If necessary, unlock the side cover.

4. Remove the two screws that secure the side cover to the rear

of the server.

5. Using the side cover handle, release the side cover by sliding it

toward the rear of the server.

6. Move the side cover outward and away from the server.

Figure 21: Removing the side cover
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8 .3 .2 Returning the side cover

1. Verify that the server is off and that all external cables are

disconnected.

2. Clear any cables that might impede returning the side cover.

3. With the server in the upright position, rest the bottom of the side

cover on the bottom rail of the chassis.

4. Align the slots in the side cover with the matching tabs in the

chassis. Insert the side cover into the slots.

5. Slide the side cover toward the front of the server.

6. Tighten the two screws that secure the side cover to the rear of the

server.

7. Reconnect all external cables and power cords and turn on the

server.

CAUTION: For proper cooling and airflow, return the side cover before

turning on the server. Operating the server for extended periods (more than

30 minutes) with the side cover removed might damage server components.

8 .3 .3 Removing the front panel

1. Review the System Reliability Considerations.

2. Turn off the Color Controller C-81 and all peripheral devices.

Disconnect all external cables and power cords.

3. Remove the side cover.

Tip: It is easier to perform this procedure if you place the server on its side on

a table, with the front panel of the computer case protruding over the table

edge.

4. Inside the chassis, lift the two protruding tabs that secure the front

panel to the front of the chassis and move the edge of the front

panel slightly away from the chassis.
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5. Using a flat screwdriver, gently pry the four concealed tabs

along the edge of the front panel away from the chassis.

Figure 22: Removing the front panel
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6. When the front panel is free, pull it away from the front of the

chassis, and then push it downward to release the concealed tabs

along the bottom of the front panel from the chassis.

Figure 23: Front panel removed showing protruding and concealed tabs

7. Remove the front panel and store it in a safe place.

See also:

System reliability considerations on page 102

Removing and replacing the side cover and front panel on page 103

8 .3 .4 Returning the front panel

1. With the Color Controller C-81 on its side, insert the concealed

tabs along the bottom edge of the front panel into the matching

slots in the chassis.

2. Push the top of the front panel toward the server until the two

protruding tabs, and the concealed tabs along the top edge of the

front panel snap into place.

Note: While pushing the front panel into place, be careful not to damage the

USB port.

3. Return the side cover.
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4. Reconnect all external cables and power cords, and turn on the

server.

See also:

Returning the side cover on page 104

Removing the front panel on page 105

8 .4 Working with boards (adapters)
If the diagnostics check indicates that any unit components need

replacing, follow the replacement procedures.

The following diagram illustrates schematically the external

connectivity of the peripherals and the internal connectivity of the

main components of the Color Controller C-81

Figure 24: Peripherals and internal connectivity

See also:

Troubleshooting on page 85
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8 .4 .1 Visual inspection

Whenever you replace any component in the unit:

1. Check that all boards are retained properly in their slots.

2. Check that the cables are routed properly.

3. Check the existence of all the fans.

4. Check that all the disks are locked properly.

WARNING: When you handle static-sensitive devices, take precautions to

avoid damage from static electricity.

See also:

Safety precautions on page 3

8 .4 .2 Removing and installing the FusionRA board

The FusionRA board simultaneously decompresses and RIPs data for

the duration of a job. Perform the following procedures to remove and

install the FusionRA board.

Figure 25: FusionRA board inside chassis
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Removing the FusionRA board

CAUTION: Before opening the unit, ensure that the power is turned OFF and

that the unit is disconnected from the AC power socket.

1. Before you remove the FusionRA board, review the safety

precautions.

2. Turn off the Color Controller C-81 and all peripheral devices.

Disconnect all external cables and power cords.

3. Remove the side cover.

4. Gently slide the right side of the board out from its slot and

from the white clip.

Figure 26: Right side of FusionRA board in slot
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5. Using a cross-head screwdriver, remove the hexagonal screw that

holds the board at the left of the server.

Figure 27: FusionRA board

See also:

Safety precautions on page 3

Removing and replacing the side cover and front panel on page 103

Preparing the FusionRA board

1. Touch the sides of the new board’s antistatic packet to an

unpainted area of the server chassis, and then remove the new

board from the packet.

WARNING: Avoid touching the components and gold-plated connectors on

the adapter.

2. Place the board, component-side up, on a flat, antistatic surface.

Installing the FusionRA board

1. Carefully grasp the board by its top edge or upper corners, and

align it with the expansion slot on the system board.

2. Press the board firmly into the expansion slot. Verify that the board

fits securely in the expansion slot and is locked in position.

Attention: When you replace a board in the server, ensure that it is

completely and correctly seated in the system board expansion slot before

applying power. Incorrect seating might cause damage to the system board

or any other board.

3. If you have other options to remove or replace, do so now.

4. Insert the hexagonal screw that holds the board at the rear of the

server and tighten it.

5. Return the side cover.
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6. Reconnect all external cables and power cords, and turn on the

server.

See also:

Returning the side cover on page 104

8 .4 .3 Removing and installing system board memory modules

The Color Controller C-81 comes with Dual In-line Memory

Modules (DIMMs) that are installed on the system board in

DIMM bank #1A (blue) and DIMM bank #2A (blue).

Note: Removing or installing DIMMs may change the configuration

information in the server. Therefore, after removing or installing a DIMM,

save the new configuration information by using the BIOS setup utility

program. When you restart the server, the system displays a message

indicating that the memory configuration has changed.

Figure 28: DIMM module locations
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Preparing to remove a DIMM

Important: When you handle electrostatic discharge (ESD) sensitive devices, take

precautions to avoid damage from static electricity.

1. Before you start to remove a DIMM, review the safety precautions.

2. Turn off the Color Controller C-81 and all peripheral devices.

Disconnect all external cables and power cords.

3. Remove the side cover.

4. Verify which DIMM you want to remove.

See also:

Safety precautions on page 3

Removing and replacing the side cover and front panel on page 103

Installing a DIMM on page 113

Removing a DIMM

1. Press down on the two DIMM release tabs so that they rotate

outward, until the memory is released from its slot

Attention: Handle the clips gently to avoid breaking the retaining clips or

damaging the DIMM connectors.

2. Gently pull the DIMM up and out of the server.

Installing a DIMM

1. Touch the antistatic package containing the new DIMM to any

unpainted metal surface on the server, and then remove the DIMM

from the package.

2. Verify that the DIMM connector retaining clips are open.

3. Orient the memory so that the pins align correctly with the

connector.
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4. Insert the DIMM into the connector and, by pressing on the

edges of the DIMM, one at a time, allow it to click into place in

the slot . Ensure that you press the DIMM vertically into the

slot

Figure 29: Installing a DIMM

5. Verify that the retaining clips are in the closed position. If a

gap exists between the DIMM and the retaining clips, the

DIMM has not been properly installed. In this case, open the

retaining clips, remove the DIMM, and repeat the previous

step.

6. If you have other options to remove or replace, do so now.

7. Return the side cover.

8. Reconnect all external cables and power cords, and turn on the

server.

See also:

Returning the side cover on page 104

8 .5 Working with the system board
This section shows illustrations of the components on the system

board, and procedures for removing and installing the system

board.

Note: It is recommended to perform all the procedures in this section with the

server on its side on a table.

114 Chapter 8—Hardware and maintenance repairs



8 .5 .1 System board internal cable connectors

The following illustration identifies system board connectors for

internal cables.

Figure 30: System board internal cable connectors

8 .5 .2 System board external-port connectors

The following illustration identifies system board connectors for

external devices.

Figure 31: System board external port connectors

1 LAN2 (Printer)
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2 LAN1 (client network)

3 VGA port (monitor)

4 COM1 port (DTP)

5 USB ports 1/2 (mouse)

6 Keyboard

7 Optional mouse port

8 .5 .3 Removing the system board

1. Before you remove the system board, review the safety

precautions.

2. Turn off the Color Controller C-81 and peripheral devices.

Disconnect all power cords and external cables.

3. Remove the side cover.

Note: It is recommended that you place the server on its side before

continuing this service procedure.

4. Remove the FusionRA board.

5. Disconnect all the cables connected to the system board,

power supply, fans, USB cables, and hard disks.

6. Remove the CPU.

7. Remove the eight system board screws.

8. Lift the system board up and out of the server.

9. Turn over the system board and remove the metal bracket

from the board. Set aside the bracket to install on the new

system board.

See also:

Safety precautions on page 3

Removing the side cover on page 103

Removing and installing the FusionRA board on page 109

Removing and installing the central processing unit

(CPU) on page 119
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8 .5 .4 Installing a new system board

Important: When you handle electrostatic discharge (ESD) sensitive devices, take

precautions to avoid damage from static electricity.

1. Before installing a new system board, review the safety

precautions.

2. Verify that the Color Controller C-81 is turned off and that all

power cords and external cables are disconnected.

3. Touch the antistatic package containing the new system board to

any unpainted metal surface on the server, then remove the

system board from the package and place it on the worktable.

Important: When you handle electrostatic discharge (ESD) sensitive devices,

take precautions to avoid damage from static electricity.

Note: The new system board includes a new black plastic CPU load plate,

which you can discard.

4. Turn over the system board.

Note: The Color Controller C-81 is supplied with a reusable metal bracket

attached to the underside of the system board. The metal bracket is part of

the CPU cooling kit.

5. Perform the following actions to attach the metal bracket to the

system board:

a. Place the metal bracket face down on the work table and use a

knife to cut the adhesive tape on all four corners.

Figure 32: Cutting adhesive tape on metal bracket

b. Remove the adhesive tape from the four corners.
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c. Turn the metal bracket over and align it with the holes on

the system board.

d. Gently press the bracket into place.

Figure 33: Metal bracket

Note: If you are reusing a metal bracket that was attached to a

previous system board, the glue may have weakened and lost some

of its adhesiveness. Therefore, make sure to support the bracket with

one hand when installing the system board to its upright position,

6. Return the CPU.

7. Connect the CPU fan cable to the CPU Fan 1 connector.

8. Insert the system board into the chassis.

9. Align the system board with the matching hole in each

standoff insulator in the chassis.

10. Insert the eight screws into the holes. Do not tighten the

screws until all the screws are inserted.

11. Return the rear fan.

12. Return the memory modules.

13. Return the FusionRA board.

14. Reconnect all the cables that you disconnected from the

system board, power supply unit and hard disks.

Note: To assist you in reconnecting the cables to the system board, refer

to the following table.

Table 1: System board cable connections

Cable System Board Connector

Power Supply JPW1, JPW2

USB USB 2/3

USB 10/11
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Cable System Board Connector

Serial ATA SATA 0 (system disk)

SATA 1 (image disk 1)

SATA 2 (image disk 2)

SATA 3 (image disk 3 )

SATA 4 (empty)

SATA 5 (DVD/RW)

Security JL1

CPU Fan CPU Fan 1

Rear Fan Fan 5

Front Fan Fan 4

Figure 34: Front panel connectors

15. Return the side cover.

16. Reconnect all external cables and power cords, and turn on the

server.

See also:

Safety precautions on page 3

Removing the side cover on page 103

Removing and replacing the side cover and front panel on page 103

Installing the FusionRA board on page 111

Installing a DIMM on page 113

System board internal cable connectors on page 114

Removing and installing the central processing unit (CPU) on page 119

Installing the rear fan on page 141
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8 .5 .5 Removing and installing the central processing unit (CPU)

Note: The microprocessor speeds are automatically set for this server so you

do not need to set any microprocessor frequency-selection jumpers or

switches.

Preparing to remove the CPU

Important: When you handle static-sensitive devices, take precautions to

avoid damage from static electricity.

1. Before you remove the CPU, review the safety precautions.

2. Turn off the Color Controller C-81 and all peripheral devices.

Disconnect all external cables and power cords.

3. Remove the side cover.

4. Remove the FusionRA board.

5. Remove the rear fan.

See also:

Safety precautions on page 3

Removing and replacing the side cover and front panel on page 103

Removing the FusionRA board on page 110

Removing the rear fan on page 140

Removing the CPU fan and heat sink assembly

1. Locate the CPU on the system board.

Figure 35: CPU system board location

2. Locate and disconnect the CPU fan cable from the CPU Fan1

connector.
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3. Release the four spring screws that secure the CPU fan and heat

sink assembly to the system board.

Important: Loosen the screws using the crisscross method. First loosen

screws 1 and 2, and then screws 3 and 4. Once all four screws are loose,

remove them diagonally, one after the other, in the order previously

described, until all four spring screws have been removed.

4. Lift the CPU fan and heat sink assembly up and out of the server.

Removing the microprocessor

1. Unlock the microprocessor socket.

a. Press the load lever to release the load plate that covers the

CPU socket, from its locking position.

Figure 36: Unlocking the microprocessor socket

b. Gently lift the load lever to open the load plate.
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Figure 37: Opening the load plate

2. Using your thumb and index finger, carefully grasp the

microprocessor by its north and south center edges and lift it

up and out of the server.

Figure 38: Removing the microprocessor

3. Store the microprocessor in an antistatic package for possible

future use.

Installing the microprocessor

1. Touch the antistatic package containing the new

microprocessor to any unpainted metal surface on the server,

and then remove the microprocessor from the package.

2. Unlock the microprocessor socket.

a. Press the load lever to release the load plate that covers the

CPU socket, from its locking position.

Figure 39: Microprocessor socket lever
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b. Gently lift the load lever to open the load plate. Remove the

plastic cap.

Figure 40: Opening the load plate

c. Use your thumb and your index finger to hold the CPU at the

top center edge and the bottom center edge of the CPU.

Figure 41: Inserting CPU

3. Align the CPU key that is the semi-circle cutouts against the socket

keys. Once aligned, carefully lower the CPU straight down to the

socket.

CAUTION: Do not drop the CPU on the socket. Do not move the CPU

horizontally or vertically. Do not rub the CPU against the surface or against

any pins of the socket to avoid damage to the CPU or the socket.

With the CPU inside the socket, inspect the four corners of the

CPU to make sure that the CPU is properly installed.
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Figure 42: Locating pin 1 on the microprocessor socket

Note: Make sure that Pin 1 of the microprocessor socket is located at the

bottom left of the microprocessor housing.

4. Using your thumb, gently push the socket lever down and lock

it in the hook.

Figure 43: Locking the microprocessor

WARNING: The CPU will only seat inside the socket in one direction.

Make sure it is properly inserted before closing the load plate. If the load

plate does not close properly, do not force it as it may damage your

CPU. Instead, open the load plate again and double-check that the CPU

is aligned properly.

Installing the CPU fan and heat sink assembly

1. If applicable, remove the thin layer of protective film from the

copper core of the heat sink.

WARNING: If the protective film is not removed from the heat sink, the

microprocessor might overheat.

2. Position the CPU fan and heat sink assembly in such a way

that the fan wires are close to the microprocessor fan, but do

not obstruct other components.

124 Chapter 8—Hardware and maintenance repairs



3. Apply thermal grease to the top of the microprocessor. You can

apply the grease with the metal frame open or closed.

Figure 44: Applying thermal grease

4. Align the spring screws holes in the CPU fan and heat sink

assembly with their corresponding holes on the system board.

Insert the four spring screws and tighten.

Important: Make sure to insert and secure the spring screws using the

crisscross method. First insert screws 1 and 2, and lightly secure. Next insert

screws 3 and 4, and lightly secure. Once all four screws are in place, tighten

them diagonally, one after the other, in the order previously described, until

all four screws are tightened.

Figure 45: Securing the CPU fan and heat sink assembly

5. Connect the CPU fan cable to the CPU Fan 1 connector.

6. If you have other options to install or remove, do so now.

7. Return the FusionRA board.

8. Return the rear fan.

9. Return the side cover.

Working with the system board 125



10. Reconnect all external cables and power cords, and turn on the

server.

See also:

Returning the side cover on page 104

Installing the FusionRA board on page 111

Removing the CPU fan and heat sink assembly on page 120

Installing the rear fan on page 141

8 .5 .6 Removing and installing the battery

If you need to replace the battery, use a lithium battery, model

number CR2032. To avoid possible danger, read and comply with

the following safety statement.

WARNING: There is a danger of explosion if the battery is replaced

incorrectly. Replace the battery only with the same or equivalent type

recommended by the manufacturer. Dispose of used batteries according to

the manufacturer’s instructions.

The battery is located on the system board below slot 5.

Note: After you replace the battery, reconfigure the Color Controller C-81 and

reset the system date and time.

Removing the battery

1. Follow any special handling and installation instructions

supplied with the replacement battery.

2. Turn off the Color Controller C-81 and all peripheral devices.

Disconnect all external cables and power cords.

3. Remove the side cover.

4. Remove the FusionRA board to gain access to the battery.

5. Locate the onboard battery.

Figure 46: Removing the battery
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6. Using a tool such as a pen or a small screwdriver, push the battery

lock outwards to unlock it.

Figure 47: Unlocking battery

Once unlocked, the battery will pop out from the holder.

7. Use your thumb and index finger to lift the battery from the socket.

See also:

System reliability considerations on page 102

Removing and replacing the side cover and front panel on page 103

Installing the battery

1. Identify the battery's polarity. The positive (+) side should be

facing up.

2. Tilt the battery so that you can insert it into the socket on the side

opposite the battery clip.
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3. Insert the battery into the battery holder and push it down

until you hear a click to ensure that the battery is securely

locked.

Figure 48: Inserting the new battery

4. Return any adapters that you removed.

5. Return the side cover.

6. Reconnect all external cables and power cords, and turn on the

server.

CAUTION: Replacing the battery may cause the configuration to be

modified. Verify that the computer BIOS is configured properly by

performing the procedures in the BIOS setup topic.

See also:

Using the configuring tools on page 69

Configuring the order for hard disk drives on page 75

Returning the side cover on page 104

8 .6 Removing and installing the DVD-RW drive
Perform the following procedures to remove and install the DVD-

RW drive.
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Figure 49: Bay1 DVD-RW drive

8 .6 .1 Removing the DVD-RW drive

1. Before removing the DVD-RW drive, review the safety

precautions.

2. Turn off the Color Controller C-81 and peripheral devices.

Disconnect all power cords and external cables.

3. Remove the front panel and side cover.

4. Disconnect the SATA and power cable connected to the DVD-RW.

5. Using a cross-head screwdriver remove the screws that secure the

DVD-RW to the DVD-RW drive cage.

6. Gently slide the DVD-RW drive toward the front of the server, and

remove the drive.

7. Remove and set aside the metal plate from the side DVD-RW

drive.

See also:

Safety precautions on page 3

Removing and replacing the side cover and front panel on page 103
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8 .6 .2 Installing the DVD-RW drive

1. Remove the screws that secure the DVD-RW rail to the drive,

and remove the rail.

2. Position the DVD-RW rail opposite the matching holes in the

new drive. Insert the screws and tighten.

3. Insert the new DVD-RW drive, and gently slide it to the rear of

the server.

4. Reconnect the SATA and power cable to the DVD-RW drive.

5. Secure the DVD-RW drive to the DVD-RW cage.

6. Return the front panel and side cover.

7. Reconnect all external cables and power cords, and turn on the

server.

See also:

Removing and replacing the side cover and front panel on page 103

8 .7 Replacing a hard disk drive
The tasks that you need to perform before and after you remove a

hard disk and install a new one differ for a system disk and an

image disk.

To replace a system disk or both system disks and image disks,

perform the following tasks:

1. Archive any important customer jobs to an external device.

2. Back up system configuration (Preferences window).

3. Replace disk.

4. Configure RAID volume.

5. Reinstall DVD 1 and DVD 2 on the Color Controller C-81.

6. Restore system configuration (Preferences window).

7. Restore any important customer jobs that you archived.

Important: Before replacing or formatting a system disk, ensure that you have

made a note of the computer name, TCP/IP information (for example DHCP

= Yes), and OEM Windows XP Professional Product ID#.

To replace only image disks, perform the following tasks:

1. (Optional) Archive any important customer jobs to an external

device.

2. Replace disk.

3. Configure RAID volume.
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4. Format image disks.

5. (Optional) Restore any important customer jobs that you archived.

See also:

Archiving jobs on page 16

Retrieving jobs on page 22

Installing the operating system and software on page 58

Formatting image disks on page 96

Removing a hard disk drive on page 131

Installing a hard disk drive on page 132

Recreating a volume on page 133

Recreating volumes for both system and image disks on page 135

8 .7 .1 Removing a hard disk drive

1. Turn off the Color Controller C-81 and all peripheral devices.

Disconnect all external cables and power cords.

2. Remove the side cover.

Tip: You may find it easier to work if you lay the server on its side.

3. Disconnect the SATA and power cable from all the hard disks.

4. Remove the three screws that secure the drive cage to the server

chassis.

5. Lift the drive cage out of the server.

Figure 50: Removing a hard disk drive
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6. Identify which hard disk you want to remove.

7. Remove the four screws that secure the hard disk drive to the

drive cage, and slide the disk out of the cage.

See also:

Removing and replacing the side cover and front panel on page 103

8 .7 .2 Installing a hard disk drive

1. Slide the hard disk drive into the drive cage.

2. Insert the four screws that secure the hard disk drive to the

drive cage, and tighten.

3. Insert the drive cage inside the chassis, and over the locating

tabs in the front wall of the chassis.

4. Align the holes in the drive cage with the matching holes in the

chassis.

5. Tighten the four drive-cage screws and tighten.
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6. Connect the SATA2 cables into the back of each drive. Make sure

that the other end of each cable is connected to the appropriate

connector on the system board.

Figure 51: SATA2 connectors on the system board

7. Route each cable so that it does not block the air flow to the rear of

the drives.

8. Connect a power cable to the back of each drive. The connectors

are keyed and can be inserted only one way.

Note: Do not route the cables over the microprocessor and memory.

9. Connect the hard disk fan to the system board (Fan 3).

10. If you have other options to remove or replace, do so now.

11. Return the side cover.

12. Reconnect all external cables and power cords, and turn on the

server.

See also:

Returning the side cover on page 104
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8 .7 .3 Recreating a volume

Recreate a volume if you have replaced a system disk or an image

disk that was previously a member of a volume.

1. From the Windows Start menu, select Shut Down > Restart >

OK.

2. While the Color Controller C-81 is restarting, press <CTRL
+I> to enter the Configuration Utility.

Important: If you do not press <CTRL+I>, the Color Controller C-81

starts normally and you will then have to repeat this procedure.

3. In the Configuration Utility, select 2. Delete RAID Volume.

4. Use the Up and Down arrows to highlight the disk that you

want to mark as non-RAID, and then press the space bar to

select the disk.

5. Press Enter.

A message appears asking you to confirm that you want the

volume deleted.

6. Press y.

The volume is deleted from the RAID Volumes list.

7. In the Physical Disks list confirm that all the members of the

volume that you have deleted are indicated as non-RAID disks.

8. To create the volume, choose 1. Create RAID Volume and

press Enter.

9. Press Enter to keep the default volume name.

10. Press Enter to keep the default RAID Level (RAID0(Stripe).

11. Press Enter to choose the Stripe Size (128KB).

12. Press Enter to choose the Capacity (931.5 GB).
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13. Press Enter to create the specified volume.

A message appears warning you that all data on the selected disks

will be lost.

14. Type y to continue.

The volume is created and added to the list of RAID volumes.

15. For a system volume, make sure that DVD 1 is in the DVD-RW

drive.

16. Using the arrow keys choose 5. Exit and then press Enter to exit

the configuration utility.

A message appears asking you to confirm that you want to exit the

Configuration Utility.

17. Depending on the type of volume that you are recreating, do the

following actions :

Which volume are you recreating? Do these steps

System volume a. Press y to continue.

b. When the Creo Color Server

startup menu appears, perform

a complete installation as

described in Installing the

operating system and software.

Image volume a. Press y to continue.

b. If the Color Controller C-81 is

already installed, format the

image disks volume.

See also:

Installing the operating system and software on page 58

Formatting image disks on page 96

8 .7 .4 Recreating volumes for both system and image disks

Recreate both the system volume and image volume if you have

replaced a system disk and an image disk.

1. From the Windows Start menu, select Shut Down > Restart > OK.
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2. While the Color Controller C-81 is restarting, press <CTRL
+I> to enter the Configuration Utility.

Important: If you do not press <CTRL+I>, the Color Controller C-81

starts normally and you will then have to repeat this procedure.

3. Choose 3. Reset Disks to Non-RAID, and press Enter.

4. Use the Up and Down arrows to highlight the disk that you

want to mark as non-RAID, and choose it by pressing the

space bar.

5. Press Enter.

In the Physical Disks list, the disk is indicated as non-RAID.

6. To create the system volume, select 1. Create RAID Volume

and press Enter.

7. Press Enter to keep the default volume name.

8. Press Enter to keep the default RAID Level (RAID0(Stripe).

9. Press Enter to choose Select Disks.

A window appears listing the available disks.

10. Using the Up and Down arrows, navigate to disk 0, and then

press the space bar to choose the disk.

11. Using the Up and Down arrows, navigate to disk 1, and then

press the space bar to choose the disk.

12. Press Enter to choose the Stripe Size (128KB).

13. Press Enter to choose the Capacity (931.5 GB).

14. Press Enter to create the specified volume.

A message appears warning you that all data on the selected

disks will be lost.

15. Type y to continue.

The volume is created and added to the list of RAID volumes.

16. To create the image volume, select 1. Create RAID Volume

and press Enter.
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17. Press Enter to keep the default volume name.

18. Press Enter to keep the default RAID Level (RAID0(Stripe).

19. Press Enter to choose the Stripe Size (128KB).

20. Press Enter to choose the Capacity (931.5 GB).

21. Press Enter to create the specified volume.

A message appears warning you that all data on the selected disks

will be lost.

22. Make sure that DVD 1 is in the DVD-RW drive.

23. Using the arrow keys choose 5. Exit and then press Enter to exit

the configuration utility.

A message appears asking you to confirm that you want to exit the

Configuration Utility.

24. Press y to continue.

25. When the Creo Color Server startup menu appears, perform a

complete installation as described in Installing the operating system

and software.

8 .8 Removing and installing the power supply
Perform the following procedures to remove and install the power

supply.

Tip: It is easier to perform the following procedures if the server is on its side.

8 .8 .1 Removing the power supply

1. Before you remove the power supply, review the safety

precautions.

2. Turn off the Color Controller C-81 and peripheral devices.

3. Disconnect all AC power cords and external cables.

4. Remove the side cover.

5. Disconnect the power supply cables to the drives, and to the

system board (JPW1, JPW2).
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6. Apply pressure to the tabs to remove the fan and grill.

Figure 52: Removing the power supply unit
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7. Remove the four screws that secure the power supply to the server

from the rear of the server, using one hand to hold the power

supply inside the server.

Figure 53: Removing the power supply from the server

8. Gently move the power supply out of the server.

See also:

Safety precautions on page 3

Removing and replacing the side cover and front panel on page 103

8 .8 .2 Installing the power supply

1. Insert the power supply into the opening at the rear of the chassis.

2. Align the holes in the power supply with the holes in the chassis.

3. Insert the four power supply screws and tighten them.

4. Press the rear-fan bracket against the rear of the server, until all of

the tabs are in their slots, and then move the rear-fan bracket

downward until it locks into position.

5. Reconnect the internal cables from the power supply to the system

board and to the drives.

6. Return the side cover.
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7. Reconnect all external cables and AC power cords, and turn on

the server.

See also:

Returning the side cover on page 104

8 .9 Removing and installing fans
Perform the following procedures to remove and install the rear fan

and the PCI fan.

Figure 54: Rear and PCI fan connector locations
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8 .9 .1 Removing the rear fan

1. Before you remove the rear fan, review the safety precautions.

2. Turn off the Color Controller C-81 and peripheral devices.

Disconnect all power cords and external cables.

3. Remove the side cover.

4. Disconnect the fan cable from the system board connector (Fan5).

5. Press the two locking tabs, protruding through the outside of the

rear of the server, outward.

6. Lift the fan upward and out of the server.

7. Remove the four screws that secure the fan to the rear-fan bracket.

Figure 55: Rear fan

See also:

Safety precautions on page 3

Removing and replacing the side cover and front panel on page 103
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8 .9 .2 Installing the rear fan

1. Align the four holes in the new fan with the matching holes in

the rear-fan bracket, then insert the four screws and tighten.

2. Place the rear fan in position at the rear of the server.

3. Guide the two locking tabs through the top of the slots, while

aligning the other four tabs with their respective slots.

4. Press the rear-fan bracket against the rear of the server, until

all the tabs are in their slots, then move the rear-fan bracket

downward until it locks into position.

5. Reconnect the fan cable to the system board.

6. Return the side cover.

7. Reconnect all external cables and power cords, and turn on the

Color Controller C-81

See also:

Returning the side cover on page 104

8 .9 .3 Removing the PCI fan

1. Before you remove the PCI fan, review the safety precautions.

2. Turn off the Color Controller C-81 and peripheral devices.

Disconnect all power cords and external cables.

3. Remove the front panel and side cover.

4. Disconnect the fan cable from the system board connector

(Fan 4).

5. Remove the screw securing the fan to the chassis.

6. Release the two tabs from the front of the server.

7. Tilt the fan backwards and lift it upward and out of the server.

8. Remove the fan bracket and retain for future use.

See also:

Safety precautions on page 3

Removing and replacing the side cover and front panel on page 103
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8 .9 .4 Installing the PCI fan

1. Place the fan bracket on the new PCI fan.

2. Place the PCI fan in position in the front of the server.

3. Guide the two locking tabs through the top of the slots.

4. Press the fan bracket against the rear of the server, until all the

tabs are in their slots, then move the fan bracket downward until it

locks into position.

5. Insert the screw that secures the fan to the chassis.

6. Reconnect the fan cable to the system board.

7. Return the front panel and side cover.

8. Reconnect all external cables and power cords, and turn on the

server.

See also:

Removing and replacing the side cover and front panel on page 103
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9 Specifications and

standards

9 .1 Environmental requirements
This chapter lists the software installation steps, includes specifications

for the Color Controller C-81 operating environment, and provides a list

of the international safety standards to which the Color Controller C-81

conforms.

9 .2 Installation steps
● Color Controller C-81 software installation—time: approximately 30

minutes

● Full installation, operating and software—time: approximately 1 hour

● System loading—time: approximately 15 minutes

9 .3 Specifications

9 .3 .1 Dimensions and weight

Color Controller

C-81 (All

contents)

L x W x H (cm) L x W x H (in.) Weight

Packed 80 × 62 × 51 31.5 × 24.4 × 20.1 35kg/77.2 lb

Color Controller

C-81

Weight

Unpacked 56 ×  44.7  × 18.2 22 × 17.6 ×7.2 16.4 kg/36.2 lb

Packed 66  ×  61 × 30 26 × 24 × 11.8 18.9 kg/41.67 lb



WARNING:

● The Color Controller C-81 is heavy, and must be lifted by two people.

● Each person must place both hands underneath the Color Controller C-81

from the sides.

X-Rite i1

Spectrophotom

eter

L x W x H (cm) L x W x H (in.) Weight

Unpacked 15.3 x 6.7 x 7.8 6 × 2.6 × 3.1 0.25 kg/0.55 lb.

Packed 47.5 × 35.3 ×

16.5

18.7 × 13.9 × 6.3 2.7 kg/6 lb.

Monitor 19'' L x W x H (cm) L x W x H (in.) Weight

Unpacked 45 × 6.5 × 39 17.7 × 2.6 × 15 4.1 kg/9.0 lb.

Packed 51.5 x 12 x 12.5 20.3 × 4.7 × 16.7 5 kg/11 lb.

Keyboard and

mouse

L x W x H (cm) L x W x H (in.) Weight

Unpacked 44.5 x 18 x 3 17.5 x 7 x 1.2 0.8 kg/1.8 lb.

Packed 54.3 x 21 x 5.5 21.3 x 8.3 x 2.2 1.1 kg/2.4 lb.

Stand

(Contents and

Carton)

[Optional]

D x W x H (cm) D x W x H (in.) Weight

Unpacked 77× 67 × 104 30.3 x 26.4 x

40.9

28 kg/61.7 lb.

Packed 114 × 82.5 × 37 44.9 × 32.5 ×

14.6

45 kg/99.2 lb.

9 .4 Operating environment

9 .4 .1 Electrical (color server and monitor)

Input Voltage Range 100-127/200-240 V AC

Input Frequency Range 60 / 50 Hz

Ampere Rating 2.25 / 1.25 A
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9 .4 .2 Energy consumption

● 220 Vac–1.14 Aac = > 250 W = 854 BTU/hour

● 110 Vac–2Aac = > 220 W = 751 BTU/hour

9 .4 .3 Transportability

● There is no need for special tools for system transportation.

● The system is without wheels.

9 .4 .4 Acoustic Noise Level

Acoustic power level level

LwA 54.39 dB

9 .4 .5 Temperature and relative humidity

Items complying with IEC 721-3-1, 2, 3

Temperature Operating 10° C to 35° C (50° F to 95° F)

Storage –20° C to 60° C (–4° F to 140° F)

Relative humidity Operating 20% to 80%

Storage Max 5% to 65° C non-condensing

Items complying with IEC 721-3-0,1, 2, 3

Vibration Shipping Acceleration spectral density of 1m²/
s³ in frequency range of 10–200 Hz

and acceleration spectral density of

0.3 m²/sec³ in frequency range of

200–2000 Hz.

Free fall Shipping 0.25 m

Static load Shipping 10 Kpa

Stacking Shipping 3 boxes
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9 .5 .1 Safety approvals

United States and

Canada

cCSAus marking for the US and Canada.

Standards: UL 60950-1, 2nd Edition, CSA

60950-1-07, Second Edition

CB Countries CB Report & Certificate according to standards

IEC 60950-1:2005 (2nd Edition), EN

60950-1:2006, and National differences: EU

Group Differences; EU Special National

Conditions; EU A-Deviations;

AU; CA; KR; NZ; US

The CB reports have supplements that together include the

national differences for the following countries:

Argentina Italy

Australia Japan

Austria Kenya

Belgium Korea

Canada Netherlands

China Norway

Czech Republic Poland

Denmark Portugal

Finland Russian Federation

France Singapore

Germany Slovakia

Greece Slovenia

Hungary Sweden

India Switzerland

Israel United Kingdom

9 .5 .2 EMC requirements

United States FCC 47CFR part 15: 2009, subpart

B class B

Canada ICES-003: 2004 issue 4, class B

Japan VCCI V-3/2008.04, class B

Australia and New Zealand NS/NZS CISPR22:2009, class B

Europe EMC Directive 2004/108/EC
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Radiated Emissions EN55022:2006+A1:2007 Class B

Harmonics EN61000-3-2:2006

Flicker EN61000-3-3:1995+ A1:2001+

A2:2006

Immunity STD EN55024:1998+A1:2001+A2:2003

Immunity to electro static

discharge

EN61000-4-2:

1995+A1(98)+A2(01)

Immunity to radiated electro

magnetic field

EN61000-4-3: 2006

Immunity to fast transients EN61000-4-4: 2004

Immunity to voltage surges EN61000-4-5: 2006

Immunity to radio frequency

conducted disturbances

EN61000-4-6: 2007

Immunity to power frequency

magnetic fields

EN61000-4-8: 1993 +A1(01)

Immunity to supply voltage dips,

and variations

EN61000-4-11: 2004

9 .6 Reliability and maintenance
Prediction of Mean Time Between Failure (MTBF) is based on Parts

Stress method of B33216; parts stress method of Bellcore TR-

NWT-332Issue6 (12/97). The prediction was performed with CARE

software from BQR Israel.

Environment: GB Ambient temperature: 40° C (104° F).

Table 2: MTBF calculation results

Description MTBF

CMPTR,DVD R/W, SATA, IVORY 1,680,320

CMPTR,DRIVE,HD,500GB,

7.2KRPM,SATA2

2,742,980

CMPTR,MEM MODULE,

1GB,DDR3,ECC,1333MHZ

4,887,586
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Description MTBF

FAN+BACKPLATE,CPU INTEL P4

LGA1156

218,023

CMPTR,MB,X8SIL-F 350,564

CMPTR,500W, PS2 POWER SUPPLY 96,533

REAR FAN 120MM FOR SUPERMICRO

CHASSIS

218,023

FRONT FAN 92MM FOR

SUPERMICRO CHASSIS

218,023

FUSIONRA [LF] BRD ASSY 247,361

MONITOR,LCD 19"

WIDE,BLACK(1440X900)

48,387

CMPTR,BASIC BLACK USB KB &

MOUSE

58,066

9 .7 General maintenance information

General Maintenance Information

Periodic call-on None

Failure-recovery period 1.5 hours

Space required for

service

2.0 x 1.8 meters (6.7 x 6 feet)

Service tools ● Screwdriver (flat and cross-head)

● Antistatic kit

● Side cutters

Typical Space Required for Installation

Desktop position 1200 x 1200 mm (47.2 x 47.2 in.)

Stand position 800 x 800 mm (31.5 x 31.5 in.)
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